User Guide for Nolij Web

Release 6.3.x

Created 11/5/10
User Guide for Nolij Web Release 6.3.x
Copyright © 2009 - 2010, Nolij Corporation.
All rights reserved.
Created 11/5/10.

Nolij Corporation
138 Conant Street
Beverly, MA 01915
U.S.A
(888)-818-6654
http://www.nolij.com

If this guide is distributed with software that includes an end user agreement, this guide, as well as the software described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. Except as permitted by any such license, no part of this guide may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of Nolij Corporation. Please note that the content in this guide is protected under copyright law even if it is not distributed with software that includes an end user license agreement.

The content of this guide is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Nolij Corporation. Nolij Corporation assumes no responsibility or liability for any errors or inaccuracies that may appear in the informational content contained in this guide.

Nolij is a registered trademark of Nolij Corporation.

Microsoft, Office, Windows, Excel, Internet Explorer, and PowerPoint are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Corel, Corel Quattro Pro, and WordPerfect are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries in Canada, the United States and/or other countries. Apple and iTunes are trademarks of Apple Inc., registered in the U.S. and other countries. Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners. GOOGLE is a trademark of Google Inc. Palm is a trademark of Palm, Inc. All other brand and product names are or may be trademarks of, and are used to identify products or services of, their respective owners. IBM and Lotus are trademarks of International Business Machines Corporation in the United States, other countries, or both. Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

All other trademarks, product names, company names and logos are the property of their respective owners.

Think before you print

Nolij Corporation Proprietary & Confidential Information
Table of Contents

Preface ix

Audience ix
Organization x
Document Conventions xi

Chapter 1 Welcome to Nolij Web 13
What is Nolij Web? 13
What Can Nolij Web Do? 14
  Document Imaging 14
  Document Management 14
  Form Designer 15
  Workflow 15
    Priority Student Filter 16
    Financial Aid Folder Review Assistant 16
    Human Resources Performance Reviewer 16
    Finance Grant Organizer 17
  Reporting 17
  Collaboration 18

Chapter 2 Scanning Basics and Concepts 19
Determining Documents to Manage 19
Determining Your Hardware Needs 20
  Determining Cost, Volume, and Speed Requirements 20
  Determining Duplex Versus Simplex Scanning Requirements 21
  Determining Scanned Image Quality Requirements 21
    Keeping the Scanner Clean 22
    Using a Good Original 22
Table of Contents

Understanding Color Depth  22
Understanding Resolution  24
Understanding Dynamic Range  24
Understanding Output File Formats  24
Understanding Image File Formats  25
Understanding Non-image File Formats  25

Before You Scan  26
Selecting the Proper Scanning Resolution  26
Selecting Optimal Scanner Settings  26
Using Available Scanning Tools  27

Retaining Paper  27

CHAPTER 3

Before You Begin  29
Starting and Logging in to Nolij Web  29
Understanding the User Interface  31
  Toolbar  34
  Query Area  35
  Workflow Area  36
  Document Viewer  39
  Form Panel  39
  System Objects Panel  39
  Folder Objects Panel  40
  System Panel  40
  Query Results Panel  40
Customizing the Nolij Web Display  41
  Customizing Dialog Box Displays  41
  Resizing Panels  42
  Collapsing and Expanding Panels  42
  Moving Query Area and Workflow Area Fields  43
  Resizing Inbox Fields  43
  Setting Preferences  43
  Hiding and Showing Bookmarks  45
Changing Your Role  46

Understanding Workflow  47
Understanding User Roles and Privileges  48

CHAPTER 4

Using Nolij Web  51
Performing Queries  52
  Performing Subindex Queries  55
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performing Batch Queries</td>
<td>58</td>
</tr>
<tr>
<td>Creating New Batch Folders</td>
<td>59</td>
</tr>
<tr>
<td>Renaming Batch Folders</td>
<td>60</td>
</tr>
<tr>
<td>Deleting Batch Folders</td>
<td>60</td>
</tr>
<tr>
<td>Clearing Queries</td>
<td>61</td>
</tr>
<tr>
<td>Working with Folders in the Query Results Panel</td>
<td>61</td>
</tr>
<tr>
<td>Configuring How Query Results are Displayed</td>
<td>62</td>
</tr>
<tr>
<td>Clearing Query Results</td>
<td>62</td>
</tr>
<tr>
<td>Locking Query Results</td>
<td>63</td>
</tr>
<tr>
<td>Locking Query Folders</td>
<td>63</td>
</tr>
<tr>
<td>Viewing the Folder History</td>
<td>64</td>
</tr>
<tr>
<td>Setting Custom Statuses for Folders</td>
<td>64</td>
</tr>
<tr>
<td>Browsing System Files</td>
<td>66</td>
</tr>
<tr>
<td>Working with the System Objects Panel</td>
<td>66</td>
</tr>
<tr>
<td>Uploading System Files to Folders</td>
<td>66</td>
</tr>
<tr>
<td>Scanning Documents</td>
<td>67</td>
</tr>
<tr>
<td>Scanning Documents Into Query Folders or Subfolders</td>
<td>68</td>
</tr>
<tr>
<td>Scanning Single-Page Documents</td>
<td>68</td>
</tr>
<tr>
<td>Scanning Multipage Documents</td>
<td>69</td>
</tr>
<tr>
<td>Scanning Using Blank Page Detection</td>
<td>70</td>
</tr>
<tr>
<td>Rescanning Pages</td>
<td>72</td>
</tr>
<tr>
<td>Adding Scanned Pages to Documents</td>
<td>73</td>
</tr>
<tr>
<td>Changing the Default Scanner</td>
<td>74</td>
</tr>
<tr>
<td>Working with the Folder Objects Panel</td>
<td>75</td>
</tr>
<tr>
<td>Viewing the Folder Objects Panel</td>
<td>76</td>
</tr>
<tr>
<td>Opening Documents in the Folder Objects Panel</td>
<td>78</td>
</tr>
<tr>
<td>Creating Document Versions</td>
<td>79</td>
</tr>
<tr>
<td>Creating Document Versions in Firefox</td>
<td>80</td>
</tr>
<tr>
<td>Creating Document Versions in Internet Explorer 7</td>
<td>81</td>
</tr>
<tr>
<td>Viewing Document Properties</td>
<td>82</td>
</tr>
<tr>
<td>Viewing OCR Properties</td>
<td>84</td>
</tr>
<tr>
<td>Viewing Version Properties</td>
<td>87</td>
</tr>
<tr>
<td>Indexing Documents</td>
<td>89</td>
</tr>
<tr>
<td>Setting Global Documents</td>
<td>91</td>
</tr>
<tr>
<td>Setting Shared Documents</td>
<td>92</td>
</tr>
<tr>
<td>Renaming Documents</td>
<td>92</td>
</tr>
<tr>
<td>Deleting Documents</td>
<td>94</td>
</tr>
<tr>
<td>Recovering Deleted Documents</td>
<td>95</td>
</tr>
</tbody>
</table>
Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicating Documents</td>
<td>95</td>
</tr>
<tr>
<td>Merging Documents</td>
<td>96</td>
</tr>
<tr>
<td>Moving Documents into Query Folders</td>
<td>97</td>
</tr>
<tr>
<td>Moving Documents into Subfolders</td>
<td>97</td>
</tr>
<tr>
<td>Emailing Documents</td>
<td>98</td>
</tr>
<tr>
<td>Searching for Documents in the Folder Objects Panel</td>
<td>102</td>
</tr>
<tr>
<td>Searching All Documents for Specified Text</td>
<td>104</td>
</tr>
<tr>
<td>Adding Template Documents</td>
<td>107</td>
</tr>
<tr>
<td>Working with Forms</td>
<td>110</td>
</tr>
<tr>
<td>Detaching and Attaching Forms in the Form Panel</td>
<td>111</td>
</tr>
<tr>
<td>Working with Reports</td>
<td>112</td>
</tr>
<tr>
<td>Report Viewer Toolbar</td>
<td>112</td>
</tr>
<tr>
<td>Viewing Reports</td>
<td>113</td>
</tr>
<tr>
<td>Exporting Reports</td>
<td>115</td>
</tr>
<tr>
<td>Working with Documents in the Document Viewer</td>
<td>115</td>
</tr>
<tr>
<td>Supported File Types</td>
<td>116</td>
</tr>
<tr>
<td>Document Viewer Toolbar and Right-Click Menu Options</td>
<td>121</td>
</tr>
<tr>
<td>Printing Documents</td>
<td>125</td>
</tr>
<tr>
<td>Extracting Pages From Documents</td>
<td>125</td>
</tr>
<tr>
<td>Showing and Hiding Annotations</td>
<td>126</td>
</tr>
<tr>
<td>Annotating Documents</td>
<td>126</td>
</tr>
<tr>
<td>Highlighting Documents</td>
<td>127</td>
</tr>
<tr>
<td>Redacting Documents</td>
<td>128</td>
</tr>
<tr>
<td>Stamping Documents</td>
<td>128</td>
</tr>
<tr>
<td>Drawing Circles</td>
<td>129</td>
</tr>
<tr>
<td>Adding Free Text</td>
<td>129</td>
</tr>
<tr>
<td>Drawing Squares</td>
<td>130</td>
</tr>
<tr>
<td>Adding Sticky Notes</td>
<td>130</td>
</tr>
<tr>
<td>Resizing Annotations</td>
<td>131</td>
</tr>
<tr>
<td>Moving Annotations</td>
<td>131</td>
</tr>
<tr>
<td>Deleting Annotations</td>
<td>132</td>
</tr>
<tr>
<td>Modifying Annotation Colors</td>
<td>132</td>
</tr>
<tr>
<td>Modifying Annotation Text</td>
<td>134</td>
</tr>
<tr>
<td>Modifying Font Sizes</td>
<td>134</td>
</tr>
<tr>
<td>Resizing Documents in the Document Viewer</td>
<td>135</td>
</tr>
<tr>
<td>Resizing the Document Viewer</td>
<td>135</td>
</tr>
<tr>
<td>Rotating Documents</td>
<td>136</td>
</tr>
<tr>
<td>Zooming in and Out</td>
<td>136</td>
</tr>
</tbody>
</table>
Preface

This document describes Nolij Web and provides information about the tasks that you can perform with the product. See these topics for more information:

- Audience on page ix.
- Organization on page x.
- Document Conventions on page xi.

Audience

This document is intended to be used by anyone who uses Nolij Web.
Organization

This document is organized as follows:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, “Welcome to Nolij Web.”</td>
<td>Describes Nolij Web key features.</td>
</tr>
<tr>
<td>Chapter 3, “Before You Begin.”</td>
<td>Contains information about what you need to know before using Nolij Web, such as user interface descriptions.</td>
</tr>
</tbody>
</table>
This document uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer font</td>
<td>Indicates text displayed by a computer.</td>
</tr>
<tr>
<td>Bold computer font</td>
<td>Indicates text that you type.</td>
</tr>
<tr>
<td><em>Italic type</em></td>
<td>Indicates keywords, emphasized text, document titles, and variables (text for which you supply information).</td>
</tr>
<tr>
<td><strong>Bold type</strong></td>
<td>Indicates items in an interface that you click, such as buttons and menus, as well as keys you press on a keyboard.</td>
</tr>
<tr>
<td><img src="image" alt="Note:" /></td>
<td>Indicates important information.</td>
</tr>
<tr>
<td><img src="image" alt="Caution:" /></td>
<td>Indicates a situation where data loss could occur.</td>
</tr>
</tbody>
</table>
CHAPTER 1  WELCOME TO NOLIJ WEB

See these topics for more information about Nolij Web:


What is Nolij Web?

Nolij Web is a web-based document imaging and management solution for higher education institutions. It provides an automatic, integrated workflow process that enhances the flow of information between departments and individuals, significantly increasing productivity.

Nolij Web provides a variety of other features, such as reporting, instant messaging, and content management. Based fully on Java, Nolij Web works with all leading higher education Student Information System (SIS) software, integrates with all leading Enterprise Resource Planning (ERP) databases, and is supported on most browser and server platforms.
What Can Nolij Web Do?

Nolij Web provides these key features:

- Document Imaging
- Document Management
- Form Designer
- Workflow
- Reporting
- Collaboration

Document Imaging

You can scan, store, enhance, manage, and view hardcopy documents in Nolij Web.

Document Management

You can store, track, and maintain all of your electronic business information, regardless of file type or format.
Form Designer

Your administrator can create custom forms to retrieve and save data for records of information.

Workflow

The Workflow feature automates how documents, information, and tasks are passed from one individual to another according to predefined rules and procedures. With this feature, you can:

- Automate the paper and folder flow within or across academic departments to streamline decision making for admissions processes.
- Manage electronic content and distribute work according to workflow rules based on internal policy and procedure.
- Give users unlimited conditional inboxes, allowing support staff to route work to holding queues.
- Allow system administrators to track work and to reroute work systematically based on problems caused by bottlenecks, short-staffing, or sick employees.
- Use email for notification of work that must be completed.
- Review and design workflow paths for highly repetitive processes.

Some of the workflow processes that Nolij Web can provide include:

- Priority Student Filter
- Financial Aid Folder Review Assistant
- Human Resources Performance Reviewer
- Finance Grant Organizer
Priority Student Filter

A priority student workflow automatically prioritizes student folders so you can concentrate on preferred applicants. It is driven by internal functional requirements, such as automatic acceptance or applicant weighting, which gives applicants an overall decision score. It can:

- Prioritize folders based on criteria, such minimum GPA or SAT scores, defined as the important indicators of a successful applicant.

- Ensure that preferred applicants' folders are reviewed soonest, enabling staff to focus time effectively and to respond quickly to applicants.

Financial Aid Folder Review Assistant

A financial aid folder review assistant workflow automates the review and approval of a student's financial aid folder. You can:

- Automatically route financial aid folders to the appropriate reviewer.

- Readily access a student's financial aid history.

- Easily append and circulate comments.

- Attach supporting documents, such as tax forms and receipts.

Human Resources Performance Reviewer

A human resources performance reviewer workflow automates the review and approval of employee bonuses and pay raises. It allows you to:

- Automatically link performance reviews to the employee's human resources record.

- Control and monitor the flow of each review throughout the approval process.
What Can Nolij Web Do?

- Enable supervisors to record comments and sign off on a review.
- Route approved reviews to human resources or payroll for salary action in a timely manner.

Finance Grant Organizer

A finance grant organizer workflow converts institutional grant-related documentation into an intuitive virtual filing system. These documents can be automatically routed based on the rules surrounding a specific grant. With it, you can:

- Automatically route support documents, such as grant applications, approval signatures, and supporting documentation.
- Secure access to grant documents by user.
- Enable simultaneous access to grant documents for committee review.

For more information about workflow, see Starting and Logging in to Nolij Web on page 29.

Reporting

You can create ad hoc data models that display critical data for review and planning, and you can probe historical information quickly and easily to compare it to current information. In addition, you can export data to spreadsheet programs such as Microsoft® Excel® and Corel® Quattro Pro®.

You can use these data models to identify important trends and to forecast outcomes. You can also combine administrative data reports with process enhancement data to better understand process efficiencies or deficiencies.
Collaboration

You can communicate directly with other Nolij Web users using the Collaboration tool.
CHAPTER 2  

Scanning Basics and Concepts

See the following topics for information on planning for your hardware needs, as well as basic scanning concepts and best practices:

- Determining Documents to Manage.
- Determining Your Hardware Needs.
- Before You Scan.
- Retaining Paper.

Determining Documents to Manage

When deciding which documents you want to convert to an electronic format, you should choose to manage the documents that you are processing in large volumes and those that you need to access and retrieve most frequently.
Determining Your Hardware Needs

Consider some of these issues when determining what hardware you need:

- The volume of documents you will be scanning.
- The speed at which you need the scanner to operate.
- Your budget.
- The importance of the quality of scanned documents.

See the following topics for more information:

- Determining Cost, Volume, and Speed Requirements.
- Determining Duplex Versus Simplex Scanning Requirements.
- Determining Scanned Image Quality Requirements.

Determining Cost, Volume, and Speed Requirements

Nolij Web works with most types of scanning hardware, including those that scan at 5 pages per minute (ppm); 20 ppm; 40 ppm, single-sided documents; and 60 ppm, double-sided documents.

The number and type of scanners you need depend on the volume of images you will be scanning. For planning purposes, a typical medium volume scanner costs between $3,500 and $7,500 and can process approximately 40 or more ppm. Plan to use your scanners at about 40% of their rated capacity to cover the overhead of paper ordering, insertion, extraction, filing, and jam removal.

For example, using a typical 40 ppm scanner at 40% utilization, you can scan at 16 ppm. This means that approximately 7,500 pages that can be scanned per an 8-hour day, allowing you to scan over 30,000 pages per week.
Various setup scenarios may be appropriate depending on your needs, such as using multiple lower-cost and lower-volume scanners in different locations. Nolij consultants can assist you with determining the number, placement, and types of scanners for your requirements.

Determining Duplex Versus Simplex Scanning Requirements

A significant factor in determining your hardware needs is whether you require simplex or duplex scanners. Simplex scanners scan a single side of a document only; duplex scanners scan both sides of a document.

Determining Scanned Image Quality Requirements

The following topics help you understand the issues that impact the quality of scanned documents:

- Keeping the Scanner Clean.
- Using a Good Original.
- Understanding Color Depth.
- Understanding Resolution.
- Understanding Dynamic Range.
- Understanding Output File Formats.
- Understanding Image File Formats.
- Understanding Non-image File Formats.
Keeping the Scanner Clean

Make sure your scanner glass is clean before you scan images. You may periodically need to clean your scanner of dust, dirt, and other contaminants to maintain a high quality image.

Refer to your scanner manufacturer's instructions for information on cleaning your scanner.

Note: Always remove paper clips and staples from documents before scanning.

Using a Good Original

A good original is the most important factor that determines the final quality of the scanned image. It is important to use the highest quality original document as possible, as enhancement tools may not improve the condition of a poor quality document.

Additionally, the color depth of images that you scan affect the scanning process in different ways. See Understanding Color Depth for more information.

Understanding Color Depth

A computer uses units of picture elements, or pixels (also referred to as dots), to represent image information in a digital format. An image file, for instance, is a representation of hundreds, thousands, or millions of pixels arranged to appear as numbers, letters, or pictures. Computers record the intensity and color of each pixel in 1 or more bits of data. Bits are binary digits—either 0s or 1s—and are the smallest unit of measurement on a computer.

Bit depth, or color depth, describes the number of bits used to represent the color of a single pixel of an image. The greater the bit-depth of an image, the greater the information stored about each pixel. Images can be single-bit, grayscale, or color.
Single-bit Images

Single-bit images are the simplest kinds of images, using 1 bit of data to record each pixel. A maximum of 2 colors that can be displayed at any given time for a single-bit image is 2.

There are 2 types of single-bit images—line art and halftone.

Line art images are black and white, such as a photocopy. They may be single color images also—for example, mechanical blueprints or single color drawings and logos. Line art images do not contain any shade of gray.

Halftone images, such as newspaper pictures, are reproductions of images that give the illusion of gray. The black and white dots that make up the image are arranged so that the image appears in shades of gray.

Grayscale Images

Grayscale images contain black and white dots as well as shades of gray. More information is encoded in each pixel in a grayscale image than in a black and white image, allowing gray shades to be recorded and displayed.

4 bits of data are needed to reproduce up to 16 levels of gray; 8 bits are needed to reproduce the 256 levels of gray required to accurately represent most black and white photos.

Color Images

Color images contain the most complex information. To capture color images, scanners use a process based on the red, green, and blue (RGB) color model, in which red, green, and blue light are combined in various ways to produce a range of colors.

In the RGB model, 0% intensity of each of the red, green, and blue colors creates the color black; 100% intensity of each color create the color white. Equal amounts of red, green, and blue create intermediate shades of gray.
A typical low volume scanner can record and reproduce a large amount of color information—anywhere from 16.7 million colors for 24-bit scanners to 68.7 billion colors for 36-bit scanners. The extra information that can be processed by 36-bit scanners translates to more vivid color reproduction, as the scanners can display more subtle gradations of color to provide images that approach lifelike color accuracy.

**Understanding Resolution**

High resolution is important if you are processing an image through a high-end color system that carries continuous tone data from the scanner through the final film output. High resolution improves the sharpness and clarity of the dots that make up the image.

If the desired output is line art printed on a 1200 dots per inch (dpi) output device, you can interpolate, or scale, the original resolution to up to 1200 dpi, which produces smoother lines and eliminates some of the rough edges in line art scans.

**Understanding Dynamic Range**

Dynamic range is the ability of a scanner to register a wide range of tonal values from near-white to near-black. A scanner with a good dynamic range can correctly map input shades to output shades so you can see more detail in an image. A scanner with poor dynamic range cannot detect as many tonal values, therefore tending to fill in shadow areas or lose detail in brighter areas.

Most mid-range scanners have a dynamic range capable of registering a wide palette of tones and translating them into photo-realistic color.

**Understanding Output File Formats**

The size of a scanned image file and, to some extent, its quality, compared to the original size depend on both the resolution in which it is scanned and the file type in which it is saved.
There are many formats available in which to store scanned images, and you can view them in Nolij Web. See Understanding Image File Formats and Understanding Non-image File Formats for information on available output formats.

**Understanding Image File Formats**

The following list describes common graphics file formats:

- Tagged Image File Format (TIFF)—TIFF is supported by nearly all display and editing applications; therefore, it is recommended that you save images in this format.

- PICT, PICT2—PICT is generally used for line art with limited color, usually 256 colors. PICT2 is used for 8-bit grayscale or 24-bit color images.

- Graphic Interchange Format (GIF)—GIF is a highly compressed image format used to store images with 256 unique colors or less.

- Joint Photographic Experts Group (JPG or JPEG)—Among the smallest in file size, the JPEG format is used to store large color or grayscale files. However, they suffer from lossy compression, losing data every time they are saved. It is not recommended that you use this format because of degradation of the image quality over time.

- PCX—PCX is a format widely supported in various paint programs and suitable for scanned images.

**Understanding Non-image File Formats**

Nolij Web can collect and manage both scanned images and electronic documents, allowing you to keep electronic documents in their native file formats for enhanced display and manipulation. Some of the file formats supported include Microsoft® Office documents, web content, email, and multimedia.
Chapter 2  Scanning Basics and Concepts

Before You Scan

See the following topics for important information you should know before scanning documents:

- Selecting the Proper Scanning Resolution.
- Selecting Optimal Scanner Settings.
- Using Available Scanning Tools.

Selecting the Proper Scanning Resolution

Before scanning, choose the appropriate image format and set the desired resolution and scaling. If you have single-color line art, even if it is not black and white, you should scan using the line art setting. For black and white photos, set the scanner to capture as grayscale.

Typically, a resolution of 150 dpi to 240 dpi is appropriate for both display and printing. The higher the resolution setting, the larger the file size of the scanned image.

Selecting Optimal Scanner Settings

To determine your optimal scanner settings, it is recommended that you experiment with typical originals until you find the best compromise between quality and file size.

For example, if your sole requirement is to display scanned images on a monitor, you do not need to scan images any higher than at 72 dpi, because monitors are capable of displaying images at 72 dpi only. Conversely, if you must print your scanned images, consider scanning at a resolution between 200 dpi and 300 dpi.
Increasing the scan resolution results in a nonlinear increase in file size. For example, all other variables being equal, the file size of a document scanned at 300 dpi will be over four times larger than the same document scanned at 150 dpi.

**Using Available Scanning Tools**

Most scanner software packages come with image adjustment tools and preconfigured settings to compensate for lower quality originals. It is recommended that you experiment with these adjustments, using a few typical originals, to determine the combination of scanner hardware settings and software adjustments that produce the best results.

Often, brightness and contrast adjustments can improve how the image looks. Additional features, such as the black border removal, deskew, and despeckle are typically available through more robust image processing hardware.

**Retaining Paper**

Ensure that you review and understand your institutional polices for record retention and maintenance. All documents must be kept for the same length of time, whether they are electronic or hard copy.

For example, if an Admissions Office policy states that records must be kept for 10 years, the records should be kept in the imaging system for those 10 years. As long as the integrity of the original document is maintained, it does not matter that the record maintained in the imaging system is electronic.

Imaging and electronic document management standards state that a scanned copy is as acceptable as the hard copy document, as long as you can prove that the electronic document is the source of the decision making for a process.

It is recommended that you maintain original hard copy documents, after scanning them, for a minimum of one full processing period. For example, perform one years’ worth of scanning and imaging-related processing using Nolij Web before destroying
original documentation. Nolij can assist with archival strategies and storage policy development and implementation.
See the following topics before you start using Nolij Web:

- Starting and Logging in to Nolij Web on page 29.
- Understanding the User Interface on page 31.
- Understanding Workflow on page 47.
- Understanding User Roles and Privileges on page 48.

**Starting and Logging in to Nolij Web**

To start and log in to Nolij Web, do the following:

1. Start the application by doing one of the following:
   
   - Open a web browser and type the Nolij Web location. You can type the location in your browser address bar, or you can open it from the browser by selecting **File > Open** from the browser menu.
   
   - Double-click the Nolij Web shortcut icon, or (in Windows) right-click it and click **Open**, or (in Macintosh and Linux) control-click it and click **Open**.

   By default, there is no shortcut icon. You can create a desktop shortcut, or you can bookmark the startup page, to quickly access it when you subsequently log in to the application.
To add a shortcut on your desktop, do one of the following:

- In the browser toolbar, click the browser icon that appears to the left of the Nolij Web URL; then, drag and drop it to the desktop.

- In Internet Explorer, select, from the menu bar, File > Send > Link to Desktop.

- In Chrome, click and select Create application shortcuts.

To bookmark the page, do one of the following:

- In Internet Explorer, select Favorites > Add to Favorites... from the menu bar. Then, set the bookmark name and location.

- In Firefox, either select Bookmarks > Bookmark This Page from the menu bar or click in the address bar. Then, set the bookmark name and location.

- In Safari, click + in the address bar. Then, set the bookmark name and location.

- In Chrome, click in the address bar. Then, set the bookmark name and location.

The log in screen appears.

2. Type your username and password in the Username and Password fields. Your username and password are usually the same as those you use to log in to your administrative system.

Note: If there are issues starting Nolij Web or entering data in the login screen, contact your Nolij Web system administrator for assistance in establishing the necessary connection rights and privileges.

3. Click Log in.

You are logged in to Nolij Web, and the application starts.
You are logged in to Nolij Web with your default user role. Specific product functions and features are available depending on the role you use. See Understanding User Roles and Privileges on page 48.

**Note:** After a period of inactivity, configured by your Nolij Web administrator, you are prompted that you will be logged out within five minutes of further inactivity.

**Understanding the User Interface**

The user interface is customized according to your institution's specifications and for different user roles configured in Nolij Web.

For information about user roles, see Understanding User Roles and Privileges on page 48.

The following figure shows an example of the Nolij Web interface.
Chapter 3  Before You Begin

Figure 1: User Interface Elements and Descriptions

1. 2. 3. 4.

5. 6. 7. 8.

9.

User Guide for Nolij Web Release 6.3.x

Nolij Corporation Proprietary & Confidential Information
The following table describes the user interface elements.

<table>
<thead>
<tr>
<th>Callout No.</th>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Toolbar</td>
<td>Contains buttons that allow you to access Nolij Web functions. For more information, see Toolbar on page 34.</td>
</tr>
<tr>
<td>2</td>
<td>Query area</td>
<td>Contains fields into which you type query criteria. For more information, see Query Area on page 35.</td>
</tr>
<tr>
<td>3</td>
<td>Workflow area</td>
<td>Contains inboxes that you can access. For more information, see Workflow Area on page 36.</td>
</tr>
<tr>
<td>4</td>
<td>Document Viewer</td>
<td>Displays documents and allows you to annotate them. For more information, see Document Viewer on page 39.</td>
</tr>
<tr>
<td>5</td>
<td>Form panel</td>
<td>Displays forms, which display additional information associated with a query folder and collect and save information. For more information, see Form Panel on page 39.</td>
</tr>
<tr>
<td>6</td>
<td>Folder Objects panel</td>
<td>Displays documents contained in a query folder. For more information, see Folder Objects Panel on page 40.</td>
</tr>
<tr>
<td>7</td>
<td>System Objects panel</td>
<td>Displays files on your computer. For more information, see System Objects Panel on page 39.</td>
</tr>
<tr>
<td>8</td>
<td>Query Results panel</td>
<td>Displays the results of a query. For more information, see Query Results Panel on page 40.</td>
</tr>
<tr>
<td>9</td>
<td>System panel</td>
<td>Displays folders on your computer. For more information, see System Panel on page 40.</td>
</tr>
</tbody>
</table>
Toolbar

The toolbar provides access to certain application functions and contains the following elements:

Table 4: Toolbar Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Nolij Icon" /></td>
<td>Displays product information and provides access to the PDF version of the User Guide for Nolij Web Release 6.1 online. It also provides access to the Communication Window, which allows you to view informational messages and communicate with other users. See Working with the Communication Window on page 139 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Work Complete Icon" /></td>
<td>Sends a query folder to the next workflow step.</td>
</tr>
<tr>
<td><img src="image" alt="Clear Query Icon" /></td>
<td>Clears the query fields in the Query area.</td>
</tr>
<tr>
<td><img src="image" alt="Scan Icon" /></td>
<td>Allows you to scan documents into a selected folder. See Scanning Documents Into Query Folders or Subfolders on page 68 for more information. This button appears only when you select a folder in an inbox for which you have permission to scan.</td>
</tr>
<tr>
<td><img src="image" alt="View Reports Icon" /></td>
<td>Allows you to view reports. For more information, see Working with Reports on page 112. This button appears only if you have permission to view reports.</td>
</tr>
</tbody>
</table>
Table 4: Toolbar Elements and Descriptions (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Preferences" /></td>
<td>Allows you to configure user interface preferences. See Setting Preferences on page 43 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Tools" /></td>
<td>Provides access to collaboration, graphical workflow, and user summary. See Working with the Tools Menu on page 138 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Role: Data Entry" /></td>
<td>Displays the roles you belong to in Nolij Web and allows you to select the role in which you want to work. See Changing Your Role on page 46 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Logout" /></td>
<td>Logs you out of Nolij Web.</td>
</tr>
</tbody>
</table>

Query Area

This area contains fields in which you perform a search. Type the information that you want to find in the appropriate fields. For more information about performing queries, see Performing Queries on page 52.

Your user role determines if you can use the Query area. For more information about roles, see Understanding User Roles and Privileges on page 48.
Workflow Area

The Workflow area contains the inboxes that contain the folders with which you can perform work. The name of the workflow is labeled in **bold** text.

For more information about workflow, see Understanding Workflow on page 47.

**Figure 2: Workflow Area**

In the preceding figure, *Admissions Process* is the name of the workflow. *Validate Checklist*, *1st Read*, and *Final Evaluation* are inboxes that you own—they contain the folders of documents with which you can perform work, such as renaming and annotating documents. The number of folders in each inbox appears in parentheses () next to each inbox name.

*Admissions Process* is the name of the workflow and appears in **bold** text.

When you click a folder in the Query Results panel, the inbox that contains the folder appears next to the workflow name. In the following figure, *Adams, Brad, G, Tampa, FL* is contained in the *1st Read* folder; when you click the folder, *1st Read* appears next to the workflow label (*Admissions Process*).

**Figure 3: Inbox for Selected Folder in the Workflow Area**

If you have privilege to move folders to another inbox, you can click the drop-down arrow for the inbox that contains the folder you selected in the Query Results panel. When you select **Move To**, the inboxes to which you can send folders (if you are permitted to do so in Nolij Web), appear in the drop-down box. If you do not have the appropriate privileges, the **Move To** option is dimmed and unavailable.
If you click a folder that is not in your workflow or any other workflow, *Not in Workflow* appears next to the Workflow label, and the **Move To** option is dimmed and unavailable.

**Figure 4: Folder Not in Workflow**

In the following figure, you can move folders from the **1st Read** inbox to **Validate Checklist**, **1st Read, 2nd Read**, and **Final Evaluation** inboxes.

**Figure 5: Move To Drop-Down Box**

Inboxes are highlighted **blue** to indicate that a new folder has entered them.

Click an inbox to view information about the folders in the Inbox Detail dialog box.

Inboxes display the **Folder** and **Date** columns. Depending on your configuration, the query fields used to find the folders are also displayed. The Custom Status column is displayed if you have permission to set custom statuses for folders in your inbox.

In the Inbox Detail dialog box, you can do the following:
• Open a folder by doing one of the following:
  - Right-clicking the folder and selecting **Open** from the popup menu.
  - Selecting the folder and clicking **Open**.
  - Double-clicking the folder.

  The folder is displayed in the Query Results panel. See Working with Folders in the Query Results Panel on page 61.

• Move a folder to the next inbox. See Moving Folders in a Workflow on page 147.

• View folder history details. See Viewing the Folder History on page 64.

• Remove a folder from your workflow. See Removing Folders from the Workflow on page 150.

• Set a custom status for the folder. See Setting Custom Statuses for Folders on page 64.

Folders in inboxes are sorted by the date on which they were added, with the most recently added folder appearing at the top of the list.

**Note:** The Inbox Detail dialog box displays a specified number (determined by your Nolij Web administrator) of folders at one time. If there are more than the specified number of folders, the list is separated into multiple pages, with each page containing up to the specified number of folders. Use the arrows at the bottom of a page to navigate to the first, last, previous, or next page.

**Note:** For inboxes that also display query fields, you cannot sort information if results are displayed on more than one page in the Inbox Detail dialog box.

Your user role determines if you can use the Workflow area. It also determines if you can view and use inboxes. For more information about roles, see Understanding User Roles and Privileges on page 48.
Document Viewer

The Document Viewer displays a selected document and allows you to annotate the document in a number of ways, such as adding highlights and stamps. For more information about the Document Viewer, see Working with Documents in the Document Viewer on page 115.

Your user role determines if you can annotate documents. For more information about roles, see Understanding User Roles and Privileges on page 48.

Form Panel

The Form panel displays forms, which display SIS information associated with a query folder. Forms can also collect and save information back to the database; later, this information can be retrieved, modified, and resaved to the database. For more information about working with forms, see Working with Forms on page 110.

Your user role determines if you can view and use forms. For more information about roles, see Understanding User Roles and Privileges on page 48.

System Objects Panel

This panel displays the objects contained in system folders. Its contents are displayed after you click a folder in the System panel. For more information about this panel, see Working with the System Objects Panel on page 66.

Your user role determines if you can drag and drop files from this panel into a query folder. For more information about roles, see Understanding User Roles and Privileges on page 48.
Folder Objects Panel

This panel displays the objects contained in a query folder. Its contents are displayed after you click the containing folder in the Query Results panel. For more information about this panel, see Working with the Folder Objects Panel on page 75.

Your user role determines if you can do the following in this panel:

- View documents in a query folder (including the types of files you can view).
- Index documents.
- Delete and rename documents in a query folder.

For more information about roles, see Understanding User Roles and Privileges on page 48.

System Panel

This panel allows you to browse the drives on your computer and view them in Nolij Web. Click ▶ to expand folders; click ◄ to collapse them. Click a folder to view its contents in the System Objects panel. For more information about this panel, see Browsing System Files on page 66.

Your user role determines if you can drag and drop files from your computer into Nolij Web. For more information about roles, see Understanding User Roles and Privileges on page 48.

Query Results Panel

This panel contains the results of your query. Click ▼ to collapse the results; click ◄ to expand the results.
Your user role determines if you can lock query folders in this panel. For more information about roles, see Understanding User Roles and Privileges on page 48.

Customizing the Nolij Web Display

You can modify the Nolij Web display in a number of ways, such as resizing panels and moving fields in the Query and Workflow Areas.

When you log out of the application, the Nolij Web layout that is configured becomes the default layout. When you log in again, this layout is used.

You can also change how tables of information show information for Nolij Web dialog boxes that contain tables.

See these topics for more information:

- Customizing Dialog Box Displays on page 41.
- Resizing Panels on page 42
- Collapsing and Expanding Panels on page 42.
- Moving Query Area and Workflow Area Fields on page 43.
- Resizing Inbox Fields on page 43.
- Setting Preferences on page 43.

Customizing Dialog Box Displays

For Nolij Web dialog boxes that contain tables of information, you can choose the columns of information you want to view or hide, sort information alphabetically, and resize the width of columns.
To select the columns that are displayed and to sort columns:

1. In the dialog box, point your mouse to the edge of a column and click δ.

2. Click Sort Ascending to sort information alphabetically in a high to low sequence (A to Z).

3. Click Sort Descending to sort information alphabetically in a low to high sequence (Z to A).

4. Click Columns.

5. Check the checkbox for the column you want to display.

To resize the width of a column, point your mouse over the edge of a column until the mouse pointer changes to ||; then, drag and drop your mouse to the desired location to resize the column.

**Resizing Panels**

To resize a panel, place your mouse on the edge of a panel. When the mouse pointer changes to || (to horizontally resize a panel) or دراسة (to vertically resize a panel), click your mouse to select the panel; then, drag and drop the panel to the desired location to resize it.

**Collapsing and Expanding Panels**

You can collapse and expand several Nolij Web panels. Click  to collapse a panel; click  to restore it.
Moving Query Area and Workflow Area Fields

You can move fields in the Query and Workflow areas. To do so, place your mouse over a field. When the mouse pointer changes to \( \text{itura} \), you can select the field and drag and drop it to the desired location.

You can change the order of fields within a query, but you cannot change the order of queries themselves, if you have multiple queries. This means that, for queries that have only one field—for example, batch queries—you cannot move that query field.

Resizing Inbox Fields

You can resize the inboxes in the Workflow area. To do so, place your mouse at the right edge of a field. When the mouse pointer changes to \( \text{arrrt} \), you can drag and drop the field to resize it.

Setting Preferences

You can change the colors in the Nolij Web user interface and expand and consolidate the field labels in the Query and Workflow areas. See these topics for more information:

- Configuring Display Options on page 44.
- Changing User Interface Colors on page 44.
- Hiding and Showing Bookmarks on page 45.
- Detaching and Attaching Forms on page 46.
Configuring Display Options

1. From the toolbar, click 

2. From the popup menu, select **View Options**.

3. Select one of the following options:
   - Horizontal—Places the Query area at the top of the Nolij Web application window.
   - Vertical—Places the Query area to the left of the Nolij Web panels.
   - Hide Workflow—Hides the Workflow area.

Changing User Interface Colors

You can change the colors used in the Nolij Web interface.

1. From the toolbar, click 

2. From the popup menu, select **Themes**.
3. From the popup menu, click the color scheme you want to use. The theme that you are using is dimmed and unavailable. You can select from the following options:

- Blue Theme
- Gray Theme
- Slate Theme
- Access Theme

A dialog box appears.

**Note:** Do not click **Yes** if you have unsaved work that you would like to save before you change the color scheme. If you click **Yes**, Nolij Web refreshes, and you lose your work.

4. To change the color scheme, click **Yes**.

The application refreshes, and the new color scheme is applied.

## Hiding and Showing Bookmarks

You can hide the bookmarks icons from the Document Viewer toolbar by doing the following:

1. From the toolbar, click ![Preferences](preferences.png).

2. From the popup menu, select **Document Viewer > Hide Bookmarks**.

   If bookmark icons were displayed in the Document Viewer toolbar, they are hidden.

   If bookmark icons were hidden, they are displayed.
Detaching and Attaching Forms

You can separate a form from the Nolij Web application, and you can reattach a separated form to Nolij Web.

1. From the toolbar, click Preferences.

2. From the popup menu, select Form > Detach Form.

   If the form was attached to the Nolij Web interface, it becomes detached, and you can move the form within the browser running Nolij Web.

   If the form was detached, it is reattached to the Nolij Web interface.

   You can also detach and reattach forms in the Form panel. See Detaching and Attaching Forms in the Form Panel on page 111.

Changing Your Role

To change your user role, select the role in which you want to work from the Role drop-down box in the toolbar. The drop-down box contains all of the roles to which you belong.

The application refreshes, and the user interface for the role in which you are working appears.

For more information about user roles, see Understanding User Roles and Privileges on page 48.
Understanding Workflow

*Workflow* is the automatic process by which the electronic information in Nolij Web is sent from one user to another. An example workflow might involve the following tasks:

1. Applications are received by a clerk, who verifies that all required documents are present.

2. When Step 1 is complete, applications are sent to an assistant who reads the documents.

3. When Step 2 is complete, applications are sent to a director for final approval.

Nolij Web represents this information as virtual folders, which contain the documents associated with records of information.

Folders are routed to inboxes in the Workflow area. You can route a folder manually, or a folder can be routed automatically, based on the Nolij Web configuration for your institution.

In an automatic workflow, when you click ![Work Complete](https://example.com/work-complete) in the toolbar or from the folder's right-click menu in the Query Results panel, the workflow process starts, and Nolij Web routes the folder to the appropriate inbox when the proper conditions are met.

For example, a workflow may require that a folder contain an essay, transcript, and application before it can be routed to the next inbox. If a folder contains all documents, it is passed to the next inbox; however, if the folder does not have all required documents, it will not be passed along in the workflow.

You can override the automatic workflow process for a folder for which you have the appropriate privileges by selecting, from the drop-down box that contains all the inboxes to which you can route folders, the inbox to which the folder is routed next.

Nolij Web does not send information along in the workflow if any conditions are not satisfied, and it alerts you if this is the case.
Understanding User Roles and Privileges

When you log into Nolij Web, you are logged in to the application with your default role. What you can do with Nolij Web is dependent upon your user role, to which a collection of privileges is assigned. These privileges determine the features you can access and the tasks that you can perform.

The following list describes the tasks that you can perform when you have the appropriate privileges:

- Search for documents using keywords.
- View reports.
- View and use forms.
- Collaborate with other users.
- View and use specific inboxes.
- Override the workflow process by manually routing folders to any inbox you can access.
- View specific documents in a query folder (including the types of files you can view).
- Edit, annotate, and scan documents.
- Drag and drop files from the Nolij Web System panel into a query folder.
- Delete and rename documents in query folders.
- Recover deleted documents.
- Index documents (including selecting and viewing the indexes you can use).
- Print and email documents.
- Open a document in the application that is designated to open the particular type of file (for example, an HTML file opens in Microsoft® Internet Explorer®, if Internet Explorer is specified as the application that opens HTML files).
- Lock query results.
• Remove folders from the workflow.
• View and use stamps.
• Set custom statuses.
• Create a copy of a template document.
• Create versions of documents.
CHAPTER 4  USING NOLIJ WEB

See these topics for information on using Nolij Web:

- Performing Queries on page 52.
- Working with Folders in the Query Results Panel on page 61.
- Browsing System Files on page 66.
- Working with the System Objects Panel on page 66.
- Scanning Documents on page 67.
- Working with the Folder Objects Panel on page 75.
- Searching for Documents in the Folder Objects Panel on page 102.
- Searching All Documents for Specified Text on page 104.
- Working with Forms on page 110.
- Working with Reports on page 112.
- Working with the Communication Window on page 139.
- Viewing the Graphical Workflow on page 141.
- Viewing the User Summary on page 147.
- Moving Folders in a Workflow on page 147.
Performing Queries

Use Nolij Web to query records to access electronic content, such as scanned images and other types of digital content, from your Nolij Web repository. You can search for information based on criteria, such as date of birth, name, and address. Nolij Web displays the information retrieved from a query as folders, which contain all documents associated with the record of information.

To perform a query, do the following:

1. In the search fields in the Query area, set the appropriate values, or part of the value, for the data that you want to find.

   In text fields, you can use the % sign as a wildcard to broaden searches if you do not have all of the required information. Use this value in a search term to represent one or more other characters.

   For example, you may not know if the applicant Joe Smith used the name Joseph, Joey, or Joe as the name on his application. To query his record, you can type Smith in the Last Name text field and J% in the First Name text field. The results of the query show all applicants with the last name Smith and the first letter J (for example, Joe, Joseph, Jane, and Jon).
Figure 6: Example of Query Results Using a Wildcard Search

For information on searching for documents containing specified text, see Searching All Documents for Specified Text on page 104.

**Note:** If you have multiple queries, the fields for a query that is not in use are dimmed.
2. After setting the search criteria, press **Enter** on your keyboard.

The results are displayed as virtual folders in the Query Results panel. Click ➕ to collapse the results; click ➖ to expand them.

When you perform a query to find a folder, the name of your query, configured by your Nolij Web administrator, appears and contains all the folders found by the query in the Query Results pane.

In addition, a number is appended to the name of the query, which denotes the order of the searches performed. For example, for the first query you perform, 1 is appended, for the second query, 2 is appended, and so on.

**Figure 7: Folder Found by Query**

![Folder Search Result]

**Note:** The Query Results panel displays 100 results at a time. If the query returns more than 100 results, the first 100 are displayed.

You can open folders in an inbox and display them by doing the following:

1. Click an inbox in the Workflow area. The Inbox Detail dialog box appears.

2. Open a folder by doing one of the following:
   - Right-clicking the folder and selecting **Open** from the popup menu.
   - Selecting the folder and clicking **Open**.
   - Double-clicking the folder.

   The folder is displayed in the Query Results panel.

When you open a folder that is in an inbox in your workflow, **Workflow folder** appears and contains the folder found by the query in the Query Results pane.

In addition, a number is appended to **Workflow folder**, which denotes the order of the searches performed. For example, for the first batch query you perform, 1 is appended, for the second query, 2 is appended, and so on.
Performing Subindex Queries

In a typical Nolij Web query, documents are associated with a primary value, such as a name, and are associated with a single folder. However, subindexed documents are associated with a secondary value. Examples of subindexed documents could include gifts received from donors and invoices received from purchase orders.

For instance, for a query that displays all gifts associated with a donor, the folder represents the primary value to which a gift is associated, such as the name of the donor. The subindex represents the secondary value to which a gift is associated, such as the gift number.

When you perform a subindex query to find a folder, the name of your query, configured by your Nolij Web administrator, appears and contains all the folders found by the query in the Query Results pane.

In addition, a number is appended to the name of the query, which denotes the order of the searches performed. For example, for the first subindex query you perform, 1 is appended, for the second query, 2 is appended, and so on.

Figure 9: Subindex Query Results Example
In subindex queries, the first query field that is displayed in the Query area is used as the subindex—the secondary value to which a document is associated—for which you search. This field is used as the label for the subindex in the Query Results panel.

For example, in the following figure, Gift # is the subindex field. Gift # is used as the label for the subindex within a folder. For instance, for the subindex 1850001, 1850001 is a Gift #.

**Figure 10: Subindex Field Example**

If you use only the first query field to perform a subindex query, a icon appears next to the query results in the Query Results panel. The query returns results for only the subindex that matches the value entered into the first query field.

For example, if you type 1850001 in the Gift # field, results are returned for only the 1850001 subindex.
Figure 11: Subindex Query Results Using First Query Field

If you use any other query field to perform subindex query, a ⌘ icon appears next to the query results in the Query Results panel. All of the subindexes and documents associated with the folder are displayed.

For example, if you type Fisher into the Last Name field, all results associated with the folder are displayed.
If a document is associated with the subindex, the Query Results panel displays the subindex with the icon. If no documents are associated with the subindex, it is displayed with the icon.

In a subindex document query, when you add a document to a subindex, the document is automatically associated with the subindex, and its document type changes accordingly.

For example, if you add the document Donation.pdf to the subindex 1850001, Donation.pdf is automatically assigned the document type Gift, which is the value of the 1850001 subindex. Additionally, the document is renamed to 1850001 Gift (for more information about renaming documents, see Renaming Documents on page 92.

### Performing Batch Queries

Batch folders are used to store documents that are not associated with any particular record, such as batches of scanned documents or miscellaneous documents. If your institution has batch queries configured, you can search for a batch folder using the appropriate field.
Typically, batch folders are not associated with workflows, and folders cannot be routed to other inboxes—they are static folders.

To search for a batch folder, select the batch folder from the batch query drop-down box. The results are displayed in the Query Results panel. When you perform a batch query to find a folder, the name of your batch, configured by your Nolij Web administrator, appears and contains all the folders found by the query in the Query Results pane.

In addition, a number is appended to the name of the query, which denotes the order of the searches performed. For example, for the first batch query you perform, 1 is appended, for the second query, 2 is appended, and so on.

Figure 13: Folder Found by Batch Query

Creating New Batch Folders

To create a new batch folder, do the following:

1. In the batch query field, type the name of the batch folder you want to create.
   The Create New Record dialog box appears.

2. To create a new batch folder, click Yes.

3. Press Enter on your keyboard.
   The batch folder is created and is displayed in the Query Results panel.
After you have created a batch folder, you can add documents to the folder by doing any of the following:

- Uploading system objects to a the batch folder. See Uploading System Files to Folders on page 66.

- Moving folder objects from a folder to the batch folder. See Moving Documents into Query Folders on page 97.

- Scanning documents and adding them to the batch folder. Scanning Documents Into Query Folders or Subfolders on page 68.

### Renaming Batch Folders

To rename a batch folder, do the following:

1. Right-click the batch query field.

2. Select **Rename** from the popup menu.

   The Rename dialog box appears.

3. Type a name for the batch folder and click **OK**.

   The batch folder is renamed and appears in the Query Results panel.

### Deleting Batch Folders

To delete a batch folder, in the Query Results panel, right-click the batch folder and click **Delete Batch Folder**. The folder is deleted and is removed from the Query Results panel.
Clearing Queries

To clear query information in the Query area, click \(\text{Clear Query}\) in the main toolbar.

Working with Folders in the Query Results Panel

Note the following:

- When you click a folder in the Query Results panel, the inbox that contains the folder appears next to the workflow name. See Figure 3 on page 36.

- If you have privileges to move folders to another inbox, you can click the drop-down arrow for the inbox that contains the folder you selected in the Query Results panel. When you select Move To, the inboxes to which you can send folders (if you are permitted to do so in Nolij Web), appear in the drop-down box. If you do not have the appropriate privileges, the Move To option is dimmed and unavailable. See Figure 5 on page 37. For more information about moving documents, see Figure on page 147.

- When you click a folder that is not in your workflow or in other workflow in the Query Results panel, Not in Workflow appears next to the Workflow label.

In the query results panel, you can do the following:

- Customize how Nolij Web displays query results. See Configuring How Query Results are Displayed on page 62.

- Remove query results from the panel. See Clearing Query Results on page 62.

- Lock query results. See Locking Query Results on page 63.

- Lock query folders. See Locking Query Folders on page 63.

- View the folder history. See Viewing the Folder History on page 64.
• Remove the folder from the workflow. See Setting Custom Statuses for Folders on page 64.

• Manually route a folder to another inbox. See Removing Folders from the Workflow on page 150.

• Add a template document. See Setting Custom Statuses for Folders on page 64

Configuring How Query Results are Displayed

In the Query Results panel, click ☰ to open a popup menu that allows you to configure certain display options. See the following table for more information.

Table 5: Query Results Panel Options

<table>
<thead>
<tr>
<th>Click This…</th>
<th>To Do This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear All Results Before Each Query</td>
<td>Clear all query results from the Query Results panel each time before a new query is performed.</td>
</tr>
<tr>
<td>Expand All Results</td>
<td>Expand the results in the Query Results panel.</td>
</tr>
<tr>
<td>Collapse All Results</td>
<td>Collapse the results in the Query Results panel.</td>
</tr>
<tr>
<td>Clear All Results</td>
<td>Clear all query results in the Query Results panel.</td>
</tr>
</tbody>
</table>

Clearing Query Results

Click ☰ in the Query Results panel to remove the results from the panel. You can also click ☰ in the Query Results panel and select Clear All Results from the menu.
Locking Query Results

To lock query results, right-click the query results and click **Lock Query Results**. A lock icon appears next to the query results to indicate that it is locked.

*Figure 14: Locked Query Results*

Locking query results prevents the Query Results panel from being cleared when you click 🗑️ or when you run another query with the Clear All Results Before Each Query option enabled.

To unlock query results, right-click the query results and click **Unlock Query Results**.

Locking Query Folders

Your user role determines if you can lock query folders. For more information, see *Understanding User Roles and Privileges on page 48*.

When you select a folder that is not locked by another user, you lock the folder for your own use. Other users can see folder contents but cannot make any changes. If you select a folder locked by another user, Nolij Web displays a message stating that the folder is locked and changes cannot be made.
Viewing the Folder History

To view folder history information, which provides information about the movement of a folder through your workflow, do one of the following:

- Right-click the folder in the Query Results panel; then, select History from the popup menu.

- Click an inbox in the Workflow area; then, right-click the folder in the Inbox Detail dialog box and select History from the popup menu.

The Folder History dialog box appears and displays the following information about the folder:

- User—Username of the user who sent the folder to the destination inbox.
- Source Inbox—Inbox from which the folder was sent.
- Destination Inbox—Inbox to which the folder was next sent.
- In—Time and date on which the folder was received in the inbox.
- Out—Time and date on which the folder was sent from the inbox.

History is not displayed for folders not in your workflow or any other workflow.

Setting Custom Statuses for Folders

You can set a custom status, which consists of a label and color, to a folder. The statuses you can set for a folder depend on your Nolij Web configuration.

For example, custom statuses can be used to set reminders for tasks you need to complete for a folder.
Your user role determines if you can set custom statuses on folders. For more information about roles, see Understanding User Roles and Privileges on page 48.

1. Click on an inbox in the Workflow area.

   The Inbox Detail dialog box appears.

2. Right-click the folder in the dialog box and select **Custom Status** from the popup menu. To select multiple folders:

   - Click a folder and press and hold the **Ctrl** key as you click each folder with your mouse.
   - Click a file and press and hold the **Shift** key as you click another folder to select contiguous folders.

3. Select the status from the popup menu.

   The status is applied to the folder, and the Custom Status column refreshes to display the color and label for the status.

To remove a custom status, right-click the folder (or select multiple folders and right-click them) and select **None** from the popup menu.
Browsing System Files

You can browse for files on your system using the System panel. Click † to expand folders; click ‡ to collapse them.

Files located in a System folder are displayed in the System Objects panel when you click the folder. See Working with the System Objects Panel on page 66 for more information.

Working with the System Objects Panel

This panel displays the files contained in a folder on your computer. Its contents are displayed after you click the containing folder in the System panel.

See these topics for more information:

- Uploading System Files to Folders on page 66.

Uploading System Files to Folders

Your user role determines if you can upload system files to a folder and the types of files you can upload. For more information about roles, see Understanding User Roles and Privileges on page 48.
You can upload files of various types—for instance, word processing, text, audio, and video—to a folder by doing the following:

1. In the Query Results panel, click the folder to which you want to upload a file.

2. Click the file you want to add in the System Objects panel. To select multiple files:
   - Click a file and press and hold the Ctrl key as you click each file with your mouse.
   - Click a file and press and hold the Shift key as you click another file to select contiguous files.

3. With your mouse, drag and drop the file into either the Folder Objects panel or the Query Results panel. You do not need to select a folder in the Query Results panel if you want to upload a file to it.

   The file is uploaded into the folder.

See Working with the Folder Objects Panel on page 75 for information on what you can do with files in the Folder Objects panel.

**Scanning Documents**

See these topics for more information:

- Scanning Documents Into Query Folders or Subfolders on page 68.
- Rescanning Pages on page 72.
- Adding Scanned Pages to Documents on page 73.
- Working with the Folder Objects Panel on page 75.
Scanning Documents Into Query Folders or Subfolders

After you have performed a query, you can scan documents into the folder.

Your user role determines if you can scan documents into a folder. For more information about roles, see Understanding User Roles and Privileges on page 48.

**Note:** To scan paper documents into Nolij Web, you must have a TWAIN-compliant scanner attached to your machine and the appropriate TWAIN drivers installed.

See these topics for more information:

- Scanning Single-Page Documents on page 68.
- Scanning Multipage Documents on page 69.
- Scanning Using Blank Page Detection on page 70.

Scanning Single-Page Documents

To scan a single page, do the following:

1. In the Query Results panel, click the folder into which you want to add a scanned document.

2. To scan a document into a subfolder, click the subfolder in the Folder Objects panel.
3. Press ![Scan]

- The first time you press ![Scan] after you log in to Nolij Web, Nolij Web prompts you to select the default scanner to use for this login session only. The scanner is not saved as the default scanner to use after you log out; the next time you log in, you must select the default scanner for that particular session.

- If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

You can change the default scanner; for more information, see Changing the Default Scanner on page 74.

When scanning starts, a progress bar appears and indicates the time that elapses during the scanning process. You cannot perform any other Nolij Web activity while the progress bar is displayed.

The document is scanned into the folder and is stored on the file server. After scanning completes, Nolij Web displays a popup message, which displays the number of pages scanned, in the lower rightmost corner of the application.

**Scanning Multipage Documents**

You can scan multipage TIFF images and save them as a single document.

1. In the Query Results panel, click the folder into which you want to add a scanned document.

2. If you want to scan a document into a subfolder, click the subfolder in the Folder Objects panel.

3. In the toolbar, click the drop-down portion of the ![Scan] button and check the Multi Page checkbox.

4. To enable Nolij Web to detect blank pages, which function as document breaks and creates merged, multipage documents, see Scanning Using Blank Page Detection on page 70.
Chapter 4 Using Nolij Web

5. Press \[\text{Scan}\]. One of the following occurs:

- The first time you press \[\text{Scan}\] after you log in to Nolij Web, Nolij Web prompts you to select the default scanner to use for this login session only. The scanner is not saved as the default scanner to use after you log out; the next time you log in, you must select the default scanner for that particular session.

- If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

You can change the default scanner; for more information, see Changing the Default Scanner on page 74.

When scanning starts, a progress bar appears and indicates the time that elapses during the scanning process. You cannot perform any other Nolij Web activity while the progress bar is displayed.

The document is scanned into the folder and is stored on the file server. After scanning completes, Nolij Web displays a popup message, which displays the number of pages scanned, in the lower rightmost corner of the application.

**Scanning Using Blank Page Detection**

You can enable Nolij Web to detect blank pages, which function as document breaks. You can scan a stack of documents with blank pages separating the documents; when Nolij Web detects blank pages, it creates separate scanned documents, with each document split based on blank pages. Blank pages are not kept as part of any document.

For example, if you place six pages on a scanner, and page 3 is a blank page, the scan process produces two documents. The first document consists of pages 1 and 2, and the second document consists of pages 4, 5, and 6.

**Note:** You do not need to provide blank pages for the first or last pages in the scanned documents.
**Note:** For double-sided documents, Nolij Web does not use blank pages on the back sides of the pages you scan as page separators. They are considered regular pages and are added to the document.

To detect blank pages:

1. In the Query Results panel, click the folder into which you want to add a scanned document.

2. If you want to scan a document into a subfolder, click the subfolder in the Folder Objects panel.

3. In the toolbar, click the drop-down portion of the button and check the **Multi Page** checkbox.

   1. In the toolbar, click the drop-down portion of the button and check the **Enable Blank Page Detection** checkbox.

   2. In the toolbar, click the drop-down portion of the button, select **Enable Blank Page Detection**, and select Set Threshold.

      The Blank Page Threshold dialog box appears.

3. Set the threshold that Nolij Web uses to determine if a page is blank. Even blank pages may have dots in the background that you do not want to scan; set the threshold, which is the ratio of white to non-white pixels (**noise**) that a page can have, so that Nolij Web can detect which pages you scan are blank or not blank.

   The values on the slider continuum range from 0 (zero) to 100. Set the value clicking the slider and dragging and dropping it to the desired location or by clicking the location to which to move the slider.

   Move the slider left to decrease the threshold; move the slider right to increase the threshold. You should use lower values for newer, cleaner scanners that are capable of removing noise; an appropriate setting for high-quality scanners ranges from 40 to 50. You should use higher values for older scanners with reduced capability for removing noise.

4. Click **OK**.
Chapter 4  Using Nolij Web

5. Press \[\text{Scan}\]. One of the following occurs:

- The first time you press \[\text{Scan}\] after you log in to Nolij Web, Nolij Web prompts you to select the default scanner to use for this login session only. The scanner is not saved as the default scanner to use after you log out; the next time you log in, you must select the default scanner for that particular session.

- If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

You can change the default scanner; for more information, see Changing the Default Scanner on page 74.

When scanning starts, a progress bar appears and indicates the time that elapses during the scanning process. You cannot perform any other Nolij Web activity while the progress bar is displayed.

The document is scanned into the folder and is stored on the file server. After scanning completes, Nolij Web displays a popup message, which displays the number of pages scanned, in the lower rightmost corner of the application.

Rescanning Pages

Your user role determines if you can rescan pages. For more information about roles, see Understanding User Roles and Privileges on page 48.

You can rescan a page and replace the page in a Nolij Web document with the rescanned page. The document must be in TIFF format.

1. In the Folder Objects panel, select the document that you want to replace.

2. In the Document Viewer, navigate to the page that you want to replace with the rescanned page.
3. Right-click anywhere in the Document Viewer and select **Rescan Page** from the popup menu.

- The first time you press the scan button after you log in to Nolij Web, Nolij Web prompts you to select the default scanner to use for this login session only. The scanner is not saved as the default scanner to use after you log out; the next time you log in, you must select the default scanner for that particular session.

- If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

  You can change the default scanner; for more information, see Changing the Default Scanner on page 74.

When scanning starts, a progress bar appears and indicates the time that elapses during the scanning process. You cannot perform any other Nolij Web activity while the progress bar is displayed.

Note the following:

- If you are rescanning one page, the selected page in the Document Viewer is replaced with that page, and all other pages in the document remain unchanged.

- If you are rescanning more than one page, the first page that you rescan replaces the selected page in the Nolij Web document; any additional pages are inserted into the document, but they do not replace any other pages.

For example, if you select page four of a ten-page document, and you rescan three pages, the first rescanned page replaces page four. The second and third rescanned pages are inserted into the Nolij Web document as pages five and six—they are added as new pages and do not replace any other existing pages. The page total of the document is 12.

### Adding Scanned Pages to Documents

Your user role determines if you can add a page to a document. For more information about roles, see Understanding User Roles and Privileges on page 48.
You can add a scanned page to a Nolij Web document that is in TIFF format.

1. In the Folder Objects panel, select the document to which you want to add pages.

2. Right-click anywhere in the Document Viewer and select **Scan Append** from the popup menu.

   - The first time you press \[ Scan \] after you log in to Nolij Web, Nolij Web prompts you to select the default scanner to use for this login session only. The scanner is not saved as the default scanner to use after you log out; the next time you log in, you must select the default scanner for that particular session.

   - If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

   You can change the default scanner; for more information, see **Changing the Default Scanner** on page 74.

When scanning starts, a progress bar appears and indicates the time that elapses during the scanning process. You cannot perform any other Nolij Web activity while the progress bar is displayed.

After Nolij Web adds the pages, a message appears and displays the number of pages that were added to the document.

### Changing the Default Scanner

You can change the default scanner that Nolij Web uses to immediately scan documents by doing the following:

1. In the toolbar, click drop-down arrow portion of the \[ Scan \] button.

2. Select **Reset Default Scanner** from the popup menu.

   The default scanner is no longer set as the default scanner.
3. The next time you press the button, Nolij Web prompts you to select the scanner to use as the default scanner.

4. From the drop-down list, select the scanner you want to use as the default scanner.

5. Click OK to close the dialog box and apply your changes.

Working with the Folder Objects Panel

When you click a folder in the Query Results panel, any documents in it are displayed in the Folder Objects panel.

In the folder objects panel, you can do the following:

- View documents in a query folder. See Viewing the Folder Objects Panel on page 76.
- Open documents. See Opening Documents in the Folder Objects Panel on page 78.
- View document, OCR, and version information. See Viewing Document Properties on page 82.
- Index a document to a defined document type. See Indexing Documents on page 89.
- Rename documents. See Renaming Documents on page 92.
- Remove documents. See Deleting Documents on page 94.
- Recover documents that you deleted. See Recovering Deleted Documents on page 95.
- Make copies of documents. See Duplicating Documents on page 95.
- Merge multiple documents into a single document. See Merging Documents on page 96.
- Move documents into query folders. See Moving Documents into Query Folders on page 97.
- Move documents into subfolders. See Moving Documents into Subfolders on page 97.
- Email documents. See Emailing Documents on page 98.
- Search for documents either by keyword or by index. See Searching for Documents in the Folder Objects Panel on page 102.
- Add template documents. See Adding Template Documents on page 107.

**Viewing the Folder Objects Panel**

Your user role determines if you can view documents in the Folder Objects panel as well as the types of files you can see. For more information about roles, see Understanding User Roles and Privileges on page 48.

Documents are displayed in the Folder Objects panel in a table that contains the following columns:

- **Name**—Name of the file. For more information about filenames, see Renaming Documents on page 92.
- **Created**—Date that the document was created.
- **Created by**—Username of the user who created the document.
- **Modified**—Date that the document was modified.
- **Modified by**—Username of the user who modified the document.
- **Size**—Size of the document.
- **Version**—For documents with versioning enabled, the latest version of the document.
You can refresh the panel to view the most current information by clicking 🔄.

**Note:** When you sort information in columns or resize the width of columns, these settings are saved as preferences and are applied the next time you log in to Nolij Web.

If subfolders are configured, and your privileges allow you to view them, the panel contains a tab for each subfolder. Click a tab to display the contents of the subfolder. The All tab displays all documents in the folder, and documents that belong to a subfolder are labeled in blue.

**Figure 16: Subfolders in the Folder Objects Panel**

![Folder Objects Panel](image)

Global documents are labeled in **bold red** for departments that did not create them; they are labeled in **bold** text when viewed by roles that created them. For more information about global documents, see Setting Global Documents on page 91.

Shared documents are labeled in **red** for departments that did not create them. For more information about shared documents, see Setting Shared Documents on page 92.

**Note:** The Folder Objects panel displays only 25 documents at one time. If there are more than 25 documents, the list is separated into multiple pages, each containing up to 25 documents. Use the arrow buttons at the bottom of a page.
Opening Documents in the Folder Objects Panel

Click a document in the Folder Objects panel to display the document in the Document Viewer, where you can annotate it (see Working with Documents in the Document Viewer on page 115 for more information).

You can view the following types of files:

- GIF
- TIFF
- JPEG
- HTML
- DOC (Microsoft Word®)
- RTF (rich text file)
- PPT (Microsoft PowerPoint®)
- XLS (Microsoft Excel)
- TXT
- BMP

To open all other types of files, double-click the file in the Folder Objects panel. The file is opened in the application designated to open the particular file type (referred to as application activation). For example, an MP3 file opens in Apple iTunes if iTunes is specified as the application that opens MP3 files).

Your user role determines if you can perform an application activation. For more information about roles, see Understanding User Roles and Privileges on page 48.

Note: You cannot see annotations if you open a file in an application other than
Creating Document Versions

If versioning is enabled and you have the appropriate permissions, you can manage changes made to Microsoft Office and Openoffice.org documents. You can open such documents in Microsoft Office on your computer, make changes, and save changes to Nolij Web. When you make changes and save documents, new versions are created and saved to Nolij Web.

When you modify a document and create a new version of it, the document is checked out—that is, the document is locked, and no other users can make changes to it. However, if you keep a document checked out and your Nolij Web session expires because of inactivity, the document is no longer checked out.

**Note:** You must be using Microsoft Office XP or later or OpenOffice.org versions that support WebDAV. You can edit documents in formats of earlier versions. You must also either use Microsoft Internet Explorer 7 or Mozilla Firefox.

When you click a document on which versioning is enabled, the latest version of the document appears in the Document Viewer. If you want to view version information, view or edit other document versions, or revert the document to a previous document version, see Viewing Version Properties on page 87.

If you are running Nolij Web in Firefox, see Creating Document Versions in Firefox on page 80; if you are running Nolij Web in Internet Explorer 7, see Creating Document Versions in Internet Explorer 7 on page 81.
Creating Document Versions in Firefox

1. In the Folder Objects panel, right-click the document that you want to edit.
2. Click Edit Document from the popup menu.
   You may receive a dialog box that prompts you to confirm that you want to open the document.
3. To proceed, click OK. The Versioning Document dialog box appears.
4. The Next Version displays the number of the next version of the document that will be created. You cannot modify this field.
5. The URL field displays the URL where the document is located. You cannot modify this field.
6. In the comment field, optionally type descriptive information.
7. Copy the text from the URL field.
8. Open the appropriate Microsoft Office or OpenOffice.org program.
9. From the Microsoft Office menu, select Open.
   The Open dialog box appears.
10. In the File name field, paste the URL you copied.
11. The filename of the document appears in the folder contents area.
12. Select the document and click Open in the Open dialog box.
13. Edit the document, and then click Save.
14. Click OK in the Versioning Document dialog box.
   The modified document is saved to Nolij Web.
   You can view version properties, view document versions in the Document viewer, edit a version of the document, and discard changes made to a document version. See Viewing Version Properties on page 87.
Creating Document Versions in Internet Explorer 7

1. In the Folder Objects panel, right-click the document that you want to edit.

2. Click Edit Document from the popup menu.
   
   You may receive a dialog box that prompts you to confirm that you want to open the document.

3. To proceed, click OK.
   
   The appropriate Microsoft Office or OpenOffice.org program opens and displays the document.

4. Edit the document, and then click Save.
   
   The Versioning Document dialog box appears.

5. The Next Version displays the number of the next version of the document that will be created. You cannot modify this field.

6. The URL field displays the URL where the document is located. You cannot modify this field.

7. In the comment field, optionally type descriptive information.

8. Click OK in the Versioning Document dialog box.
   
   The modified document is saved in Nolij Web.
   
   You can view version properties, view document versions in the Document viewer, edit a version of the document, and discard changes made to a document version. See Viewing Version Properties on page 87.
Viewing Document Properties

You can view document properties, such as document size and creation date by doing the following:

1. In the Folder Objects panel, right-click the document for which you want to view properties.

2. Click **Document Properties** from the popup menu.

   The Document Properties dialog box appears.
3. Click the **Properties** tab to view the following information:

   - Name—Name of the document.
   - ID—Numeric identifier, assigned by Nolij Web, of the document.
   - Created By—Username of the user who created the document.
Chapter 4  Using Nolij Web

- Created On—Date on which the document was created.
- Modified By—Username of the user who last modified the document.
- Modified On—Date on which the document was modified.
- Size—Size, in kilobytes, of the document.
- Version—If versioning is enabled, the version number of the document.

**Viewing OCR Properties**

You can view Optical Character Recognition (OCR) information, such as whether OCR was performed on a document and whether words were recognized or excluded.

When Nolij Web performs an OCR on a document, Nolij Web checks the words in a document against the Nolij Web dictionary. Nolij Web recognizes words that the Nolij Web dictionary contains. If Nolij Web does not recognize a word, the word is not associated with the document for a keyword search (you cannot use this word to search for the document), and Nolij Web excludes this word.

You can add excluded words to the Nolij Web dictionary; later, when an OCR is performed, Nolij Web recognizes the words you added to the dictionary.

1. In the Folder Objects panel, right-click the document for which you want to view properties.

2. Click **Document Properties** from the popup menu.

   The Document Properties dialog box appears.

3. Click the **OCR Stats** tab to view the following OCR information:
   - **OCR Status**—Status of OCR. Values can be:
     - None—No OCR was performed or is pending on the document.
     - Completed—OCR was successfully completed on the document.
     - Pending—OCR is pending for this document.
- In Queue—OCR is being performed on this document.
- To Rescan—A change on this document has occurred, and it is scheduled to be rescanned.
- Error—A problem occurred with the OCR process, and it did not complete.

- Words Found—Number of words recognized by OCR when the OCR process was most recently performed on the document.
- Words Not Recognized—Number of words that were not recognized by OCR when the OCR process was most recently performed on the document. These words appear in the Exception panel.
- % Words Recognized—Percentage of words in the document that the OCR process recognized when the OCR process was most recently performed.

Your Nolij Web administrator configures the percentage of words that OCR must recognize on a document for OCR to be successful; if the percentage of recognized words does not meet this value, a status message appears, and the document is highlighted in yellow in the Folder Objects panel.

Figure 18: Highlighted Documents in the Folder Objects Panel
The Words Found, Words Not Found, and % Words Recognized values reflect the most recent OCR process for the document. These values also reflect multiple occurrences of each word—if a word appears twice in the document, it is counted as two occurrences, not one. However, the OCR process only stores one occurrence of a word that appears multiple times.

For example, for the text is an asdf sentence an asdf sentence:

- Seven words are found (is, an, asdf, sentence, an, asdf, and sentence).
- Five words are recognized (is, an, sentence, an, sentence).
- Two words are not recognized (asdf and asdf).
- Five out of seven (78%) of words are recognized.

The OCR process only stores one occurrence of an and sentence, even though they appear twice in the text. Also, the OCR process only excludes one occurrence of the unrecognized word asdf, even though it appears twice, and asdf appears only once in the Unrecognized Word pane.

You can fix words, add them to the dictionary, or reject words; however, Words Found, Words Not Found, and % Words Recognized values are not updated. Values are updated only after an OCR is next performed.

You can remove the status message and highlight by clicking the Clear Failure Flag button.

4. To correct an unrecognized word, do the following:

   a. Select the word in the Unrecognized Words pane and click Fix.

   The Enter the corrected word dialog box appears.

   b. Type the appropriate word in the dialog box.

   c. Click OK.

   The word is removed from the Unrecognized Words pane.

   The word is corrected, and the corrected word is recognized by OCR for this document only; it is not added to the Nolij Web dictionary, so it is not recognized on subsequent OCR performances. The word is also associated with this document, and you can use it as a keyword to search for the document.
5. To allow an excluded word to be added to OCR for the document, select it in the Unrecognized Words pane and click **Accept**.

The word is removed from the Unrecognized Words pane.

The word is recognized by OCR for this document only; it is not added to the Nolij Web dictionary, so it is not recognized on subsequent OCR performances. The word is also associated with this document, and you can use it as a keyword to search for the document.

6. To add an unrecognized word to the Nolij Web dictionary, select it in the Exception pane and click **Add to Dictionary**.

The word is removed from the Unrecognized Words pane.

The OCR process will recognize this word the next time an OCR is performed, and the word is associated with this document so you can use it as a keyword to search for the document.

Additionally, this word is no longer excluded and is associated with any other document that contains this word (and for which the word is excluded).

7. To reject an excluded word, click it in the Unrecognized Words pane and click **Reject**.

The word is removed from the Unrecognized Words pane and is not associated with the document.

**Viewing Version Properties**

If document versioning is enabled, you can view version properties, view a version of the document, edit a version of the document, and discard changes made to a document version.

1. In the Folder Objects panel, right-click the document for which you want to view properties.

2. Click **Document Properties** from the popup menu.

   The Document Properties dialog box appears.
3. Click the **Version** tab to view the following information:
   
   - User—Username of the user who last modified the document.
   
   - Version—Version number of the document.
   
   - Date—Date and time on which the document was checked out.
   
   - Comments—Comments, if any, provided by the user who checked out the file or by Nolij Web.
     
     - For the first version of a document, the Comments column displays **Original Version**.
     
     - For documents to which previous document versions were reverted, the Comments column displays **Rollback to version x**, where x is the document version to which the new document was reverted.

4. To view a version of the document, select the version and click **View**.

   The version of the document is displayed in the document viewer.

5. To edit a version of the document, select the version and click **Edit**.

   When you edit the selected version, you create the latest version of the document. The Versioning Document dialog box appears. See *Creating Document Versions on page 79*.

6. To revert to the previous version of the document and discard changes made in successive versions, select the document version to which to revert and click **Rollback**.

   Changes made to the version of the document are discarded, and the latest version of the document is created. The latest version of the document is updated in the Version tab, and the Comments column displays **Rollback to version x**, where x is the document version to which the new document was reverted.
Indexing Documents

You can index, or assign a document type to, a document in the Folder Objects panel. These indexes, configured in Nolij Web according to your specifications, indicate the most commonly used types of documents that your institution manages. For instance, indexes could be W-2, Application, Transcript, or Photograph.

Your user role determines if you can index documents. For more information about roles, see Understanding User Roles and Privileges on page 48.

To index a document, do the following:

1. In the Folder Objects panel, right-click the document you want to index. To select multiple documents:
   - Click a document and press and hold the Ctrl key as you click each document with your mouse.
   - Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. From the popup menu, click the index you want to use.

   The index list contains up to 10 index types, which are either locked or are the most recently used indexes. You can lock indexes to always display them in the index list. If you have permission to index documents to more than 10 index types:
   - If you have not selected any indexes yet, Choose Index Types appears in the popup menu.
   - If you have selected an index, More Index Types... appears in the popup menu.

   Depending on your Nolij Web configuration, you may be able to index a document as a Global Document or a Shared Document. For information about global documents, see Setting Global Documents on page 91. For information about shared documents, see Setting Shared Documents on page 92.

3. If you select More Index Types..., the Choose Index Type dialog box appears, which displays the index types you have permission to view and use.

4. To lock an index type, right-click it and select Lock; to unlock a locked index type, right-click it and select Unlock.
Figure 19: Locked and Unlocked Index Types in the Choose Index Type Dialog Box.

Locked index types appear in the right-click menu for a document in the Folder Objects panel.

5. In the Choose Index Type dialog box, select the index to use.

6. Click **OK**.

The document is indexed, and the information is refreshed in the Folder Objects panel.

In addition, the document is renamed to the same name as its index. For example, a filename changes to *Application* if the index *Application* has been associated with it. You can change the filename of the document; see *Renaming Documents on page 92* for more information.
You can also index a document by giving it the same name as that of the index. For more information about renaming documents, see Renaming Documents on page 92.

Setting Global Documents

If Nolij Web is appropriately configured, and you have the necessary privileges, you can set a document as a global document. Global documents are those that are created by a specific department, and all other departments can view them.

To index a document a global document, do the following:

1. **In the Folder Objects panel, right-click the document you want to index as a global document. To select multiple documents:**
   - Click a document and press and hold the Ctrl key as you click each document with your mouse.
   - Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. **From the popup menu, check the appropriate option to index the document as a global document.**

The document is renamed and indexed as a global document. Global documents can be viewed by all other departments; they are labeled in **bold** for departments that created and are labeled in **bold red** for departments that did not create them.

**Note:** Use caution when setting global documents. After you index a document as a global one, it cannot be indexed to any other index. Also, you can only email, delete, and duplicate them (this information applies to all roles—both those that can create global documents and those who cannot).
Setting Shared Documents

If Nolij Web is appropriately configured, and you have the necessary privileges, you can set a document as a shared document. Shared documents are those that are created by a specific role and are viewable by other particular roles (specified in your Nolij Web configuration).

To index a document as a shared document, do the following:

1. In the Folder Objects panel, right-click the document you want to set as a shared document. To select multiple documents:
   - Click a document and press and hold the Ctrl key as you click each document with your mouse.
   - Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. From the popup menu, check the appropriate option to set the document as a shared document.

The document is renamed and indexed as a shared document. Shared documents can be viewed by only those roles whose privileges allow them to view the document. Shared documents are labeled in red for departments that did not create them.

Departments that cannot create shared documents can only delete, email, or duplicate shared documents.

Renaming Documents

You can rename a document or restore its original filename.

Your user role determines if you can rename a document. For more information about roles, see Understanding User Roles and Privileges on page 48.
Note the following:

- The filename must include the name of the index that you want associated with the document. For example, if you want a document indexed as an Application, the filename must include the word Application. If the index name is not included in the filename, the document is not associated with any index.

  For example, a document with the filename College Application is indexed as an Application; a document with the filename College App is not.

- When you restore a document’s original filename, the document is no longer associated with any index. If you want a document indexed, you must set the index after resetting the filename.

- If you type a name for a document that is also a index, the document is then associated with that index. For example, if you name a document Email, and Email is an index that can be assigned to the document, the index of the document becomes an Email.

  For more information about indexing documents, see Indexing Documents on page 89.

To rename a document:

1. In the Folder Objects panel, right-click the document you want to rename.

2. Click Rename from the popup menu.

   The Rename File dialog box appears.

3. Type the new filename and click OK.

   The Folder Objects panel refreshes, and the filename is updated.

To restore the original filename:

1. In the Folder Objects panel, right-click the document you want to rename. To select multiple documents:

   - Click a document and press and hold the Ctrl key as you click each document with your mouse.

   - Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. In the popup menu, click Reset Name.
The Folder Objects panel refreshes, and the filename is restored to its original filename.

Deleting Documents

Your user role determines if you can delete a document. For more information about roles, see Understanding User Roles and Privileges on page 48.

To delete a document:

1. In the Folder Objects panel, right-click the document you want to delete. To select multiple documents:
   - Click a document and press and hold the Ctrl key as you click each document with your mouse.
   - Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. Click Delete from the popup menu.

   A dialog box appears, asking you to confirm that you want to delete the document.

3. To delete the document, click Yes.

   The document is deleted and is removed from the panel.
Recovering Deleted Documents

Your user role determines if you can recover deleted documents. For more information about roles, see Understanding User Roles and Privileges on page 48.

To recover deleted documents:

1. Right-click on the folder, which contains the deleted document you want to recover, in the Query Results panel.

2. From the popup menu, select Recover Files in Folder.

   The Document Recovery dialog box appears.

3. Do one of the following:

   • To recover one document, select the document you want to recover and click Recover Document.

   • To recover all documents, click Recover All.

   Recovered documents appear in the Folder Objects panel.

Duplicating Documents

You can make a duplicate of a document by doing the following:

1. In the Folder Objects panel, right-click the document you want to duplicate. To select multiple documents:
   
   • Click a document and press and hold the Ctrl key as you click each document with your mouse.

   • Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. Click Duplicate from the popup menu.
Chapter 4 Using Nolij Web

The document is copied, and the duplicate document is displayed in the panel. Annotations are also copied and preserved in the duplicate document.

Merging Documents

You can merge multiple documents into one document by doing the following:

1. In the Folder Objects panel, select the documents you want to merge. To select multiple documents:
   • Click a document and press and hold the **Ctrl** key as you click each document with your mouse.
   • Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.

The order in which you select documents affects the properties and page order of the merged document. The first document that you select for merging is the document into which other documents are incorporated. The first document is modified and contains any other documents merged into it; all other documents are removed.

In addition, the merged document has the same properties as the first document you selected, such as name and index type. Pages are added to the merged document according to the order in which the individual documents were selected.

For example, if you first select the document *Transcript*, then select *Application*, and finally select *Essay* to be merged into one document, *Transcript* is the document into which *Application* and *Essay* are merged. In the merged document, pages are ordered by first pages in the *Transcript* document, then *Application*, and finally *Essay* pages.

2. Right-click the documents and select **Merge Selected** from the popup menu.
Moving Documents into Query Folders

Your user role determines if you can move documents into a folder. For more information about roles, see Understanding User Roles and Privileges on page 48.

You can move documents from one folder to another by doing the following:

1. In the Folder Objects panel, click the documents you want to move. To select multiple documents, click a document and hold the Ctrl key as you select each document with your mouse.

2. With your mouse, drag and drop the document into the appropriate folder or subfolder in the Query Results panel.

Note: In a subindex query, when you add a document to a subindex, the document is automatically associated to the subindex, and its subindex changes accordingly. For more information about subindex queries, see Performing Subindex Queries on page 55.

The document is moved to the folder.

Moving Documents into Subfolders

If subfolders are configured, and your privileges allow you to view them, the panel contains a tab for each subfolder.

You can move documents to another subfolder by doing the following:

1. In the Folder Objects panel, click the document you want to move. To select multiple documents:
   - Click a document and press and hold the Ctrl key as you click each document with your mouse.
   - Click a document and press and hold the Shift key as you click another document to select contiguous documents.
2. Do one of the following:

   - *(Recommended)*—Drag and drop the document to the subfolder tab.
   - Right-click the document and click Subfolder. Then, from the popup menu, click the subfolder to which you want to move the document.

   The document is moved to the subfolder.

**Emailing Documents**

If you have the appropriate privileges, you can:

   - Send an email with a link to the location from which to download a document with or without annotations.

   **Note:** Your Nolij Web administrator may configure that links to documents expire after a certain amount of days after the email was sent, that links expire after a certain amount of hours after the link was first clicked, or that links expire after a certain number of times they are clicked.

   - Send a document, with or without annotations, as an attachment in an email message.

   **Note:** A copy of the email you send is sent to your email address. If you have privileges to do so, you can change your email address.
**Note:** Depending on your Nolij Web privileges, you either send the document with annotations (if there are any) or without annotations.

1. In the Folder Objects panel, right-click the document you want to email. To select multiple documents:
   - Click a document and press and hold the **Ctrl** key as you click each document with your mouse.
   - Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.

2. Do one of the following:
   - To send an email with a link from which to download the document, select **Email Document Download Link** from the popup menu.
   - To send an email with the document as an attachment, select **Email as Attachment** from the popup menu.

   The Email Document dialog box appears.
3. The From field is dimmed and unavailable; the email is sent from your email address, which is configured by your Nolij Web administrator. If you have permission to do so, you can change your email address by doing the following:
   a. Click the **Change Email** button

   The Change Email dialog box appears.
   
   b. Type your new email address. Use the format
      `username@domain_name.com`, where the `username` is the email username and `domain_name` is the domain name of the email address.
   
   c. Click **OK** in the Change Email dialog box.

   A confirmation message is sent to the new email address.
d. You must first confirm the new email address. Open the confirmation email and click the link provided; you must open the link in the browser you are using to run Nolij Web.

e. Click OK in the Change Email dialog box.

4. In the To field, type the email address of the recipient. Use the format username@domain_name.com, where the username is the email username and domain_name is the domain name of the email address. You can send the email to multiple recipients by separating each email address with a comma (,) or semicolon (;).

5. In the CC field, type the email address of the recipient to which to send a copy of the message. Use the format username@domain_name.com, where the username is the email username and domain_name is the domain name of the email address. You can send the email copy to multiple recipients by separating each email address with a comma (,) or semicolon (;).

6. The Subject field is preconfigured to display the folder name followed by the name of the document or (if you are attaching a or sending a link to a single document) or Multiple Documents (if you are attaching or sending the link to more than one document). You can modify the subject text by typing the appropriate text in the Subject field.

7. Do one of the following:
   - Click the Original button to send the original document as an attachment; annotations, if any, are not included on the document.
   - Click the Image radio button to send the current document as an attachment; any annotations, if any, are included on the document.

8. The Message field is preconfigured to display the folder name followed by the name of the document or (if you are attaching a or sending a link to a single document) or Multiple Documents (if you are attaching or sending the link to more than one document). You can change the message text by typing the appropriate text in the Message field.

9. Click OK to send the email.

   The email is sent to the recipient
Searching for Documents in the Folder Objects Panel

You can search for documents, in the Folder Objects panel, that contain specified text, if Nolij Web is configured to perform Optical Character Recognition (OCR) on specified documents, such as TIFF or text documents. When Nolij Web performs OCR, it captures words from documents and stores them in a searchable format. You can use the text in a document to search for the document.

You can also search for documents according to their document index.

Your role determines if you can search for text. For more information, see Searching All Documents for Specified Text on page 104.

Note: When you use the search function in the Folder Objects panel, Nolij Web searches for documents in the Folder Objects panel only. To search for all documents in Nolij Web, perform a search as specified in Searching All Documents for Specified Text on page 104.

Note: When you add a document to a folder, and Nolij Web is configured to perform OCR on the document type, Nolij Web automatically performs OCR on the document; you can then perform a search for the document using text contained in it.

Do the following:

1. In the Folder Objects panel, click 📑.

2. From the popup menu, click Filter On.

3. Do one of the following:
   - Click Document Text to search for documents using key words.
   - Click Index Type to search for documents based on their index type.
4. In the text field that appears above the table, type the appropriate text. If you are searching by index type, you can also select the index type from the drop-down box.

5. Click ▶ to begin the search.

Nolij Web searches through documents in only the Folder Objects panel for the specified text. Documents that contain the text for which you searched are displayed in the Folder Objects panel.

For example, if you search for GPA in the Transcripts folder, all documents in the Folder Objects panel containing the text GPA are displayed in the Folder Objects panel.

Figure 21: Example Text Search in Folder Objects Panel

6. Click ✗ to close the search field.
Searching All Documents for Specified Text

You can search all documents in Nolij Web for specified text, if Nolij Web is configured to perform OCR on specified documents.

Your role determines if you can search for text. For more information, see Understanding User Roles and Privileges on page 48.

Note: This procedure discusses how to search for all documents in Nolij Web using specified text. To perform a search for only those documents located in the Folder Objects panel for a specific folder, see Searching for Documents in the Folder Objects Panel on page 102.

Note: When you add a document to a folder, and Nolij Web is configured to perform OCR on the document type, Nolij Web automatically performs OCR on the document; you can then search for the document using the text contained in it.

To search for documents containing specific text, do the following:

1. In the document search field in the Query area of the toolbar, type the specified text. Optionally, you can set other search criteria, such as name or address.

2. Press Enter on your keyboard.

Nolij Web searches all documents, in the folders that match your search criteria, that contain the specified text. The Query Results panel displays the results of the search. It shows the folders that contain the documents having the specified text, and it displays the documents (up to 5 at one time) that contain the text as subentries in each folder.

For example, if you search for the word application, the Query Results panel displays the folders that contain the documents with the word application; the specific documents that contain application are shown as subentries under the corresponding folders.
For example, in Figure 22 on page 105, the documents Application Summary and Image000001.tif appear as subentries in the Hallman, Robert, J, Illa, GA folder. These documents contain the text—application—specified in the text search.

Figure 22: Example Text Search in Folder Objects Panel

Note that the results in the Query Results panel display only the documents that contain the text for which you searched. A folder may contain additional documents that do not contain the specified text.

For example, click the Hallman, Robert, J, Illa, GA folder to display, in the Folder Objects panel, all documents contained in the folder. Additional documents appear in the panel, but these do not contain the text—application—for which the search was performed.
Figure 23: Additional Documents in Folder Objects Panel

If you click a document, containing the text for which you searched, in the Query Results panel, you see only documents that contain the searched text in the Folder Objects panel.

For example, if you click Application Summary in the Hallman, Robert, J, Illa, GA folder, only that document is shown in the Folder Objects panel. The panel displays only documents containing the text you searched for (application), and only Application Summary was returned as a search result.
Figure 24: Only Documents Containing Specified Search Text in Folder Objects Panel

Note that the search field in the Folder Objects panel is dimmed, showing the text used in the search.

Adding Template Documents

Your user role determines if you can add a document template. For more information about roles, see Understanding User Roles and Privileges on page 48.
You can add a document from a preconfigured template. A copy of the document is created from a template and saved to a folder of information.

1. Click \( \text{Add Template Document} \) in the Folder Objects panel and select **Add Template Document**.

The Apply Template dialog box appears and displays the document types with a template that you can add. It displays the following information:

- **Document Type**—Name of the document type.

- **Extension**—Filename extension, which is the suffix appended to a filename that denotes the program that opens a file of that type—for example, \( .tif \). *System* document types always have a filename extension; *custom* document types do not.

  - Custom document types are the document types to which you can index documents. You can associate documents of any supported file type to a custom document.

    For example, a custom document type can be named *Application*, to which you can index PDF and TIFF files.

  - System document types are those that are authored in computer applications and are stored on any computer. Microsoft® Office Word, PDF, HTML, and JPEG files are examples of system document types.

    These are specific file types; you cannot index documents to these document types, but you can index system documents to custom document types.

In the following figure, *Application* is a custom document type, and *Word/WordPerfect Document* is a system document type.
2. Select the template document and click **OK**. One of the following occurs:

- If you select a custom document type, the document is indexed to that document type and appears in the Folder Objects panel.

- If you select a system document, the Index Document dialog box appears, asking if you want to immediately index the document.
  
  - Click **Yes** to immediately index the document. The Apply Template dialog box appears and displays the document types to which you can index the document. Select the document type and click **OK**; the document is indexed to that document type and appears in the Folder Objects panel.

  - Click **No** if you do not want to index the document. The document appears in the Folder Objects panel with the name *Template*. 
Working with Forms

Note: You can only view and use forms when you have the appropriate privileges.

Forms display SIS information associated with a folder. Additionally, they can be used for collecting and adding information to the database directly. You can retrieve this information later, modify it, and resave it to the database.

To view and use a form, do the following:

1. Perform a query to display the record of information for which you want to view and use a form. See Performing Queries on page 52 for more information.

2. In the Query Results panel, click the appropriate folder.

   The form displays additional information associated with the folder.

3. If the form is configured appropriately, you can add, change, or delete information as needed. When you modify information, a red triangle icon appears in the upper left corner of the field.

   Figure 26: Modified Form Field

   ![Modified Form Field]

4. You can detach a form from Nolij Web and move it within the browser. See Detaching and Attaching Forms in the Form Panel on page 111.

5. To save your changes, click .

   Changes are saved to the database.
Detaching and Attaching Forms in the Form Panel

To detach a form, which allows you to display the Form in a detachable window, which you can move within the browser, do the following:

In the Form panel, click 🖼.

The form is displayed in a window detached from Nolij Web.

Figure 27: Detached Form Window
You can move the form by clicking on it; when the mouse pointer changes to ✉️, press down on your mouse and move the window to the appropriate location.

To resize the form, place your mouse on the edge of the form until the mouse pointer changes to ←→ (to resize horizontally), ↑ (to resize vertically), or to ← or → (to resize both horizontally and vertically).

You can reattach the form to Nolij Web by clicking 🗔️ in the detached form. The form is reattached to Nolij Web in the Form panel.

### Working with Reports

See the following topics for information about viewing and working with reports:

- Report Viewer Toolbar on page 112.
- Viewing Reports on page 113.
- Exporting Reports on page 115.

### Report Viewer Toolbar

You can open the Report Viewer by clicking 📄 in the main toolbar; the Report Viewer opens in a separate window.
The Report Viewer toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Split Screen</td>
<td>Divides the Report Viewer into two panes.</td>
</tr>
<tr>
<td></td>
<td>Single Screen</td>
<td>Merges a split screen into a single screen.</td>
</tr>
<tr>
<td></td>
<td>Export to Text File</td>
<td>Exports the report to a text file.</td>
</tr>
<tr>
<td></td>
<td>Export to Excel File</td>
<td>Exports the report to a Microsoft Excel file.</td>
</tr>
<tr>
<td></td>
<td>Pie Chart</td>
<td>Displays the report as a pie chart.</td>
</tr>
<tr>
<td></td>
<td>Line Chart</td>
<td>Displays the report as a line chart.</td>
</tr>
<tr>
<td></td>
<td>Area Chart</td>
<td>Displays the report as an area chart.</td>
</tr>
<tr>
<td></td>
<td>Point Chart</td>
<td>Displays the report as a point chart.</td>
</tr>
<tr>
<td></td>
<td>Bar Chart</td>
<td>Displays the report as a bar chart.</td>
</tr>
</tbody>
</table>

**Viewing Reports**

*Note:* You can view reports only when you have the appropriate privileges.
To view reports, do the following:

1. In the toolbar, click ![View Reports](image).
   
The Report Viewer opens in a separate window.

2. From the View Reports drop-down button, select the report you want to view.

3. You can select the format in which to view the report by selecting the appropriate option in the toolbar. You can select the following formats:
   
   - Pie chart—Click the ![Pie Chart](image) button.
   - Line chart—Click the ![Line Chart](image) button.
   - Area chart—Click the ![Area Chart](image) button.
   - Point chart—Click the ![Point Chart](image) button.
   - Bar chart—Click the ![Bar Chart](image) button.

   Additionally, you can split the screen into two panes by clicking ![Split Screen](image). Doing so enables you to view two reports—or one report in two different formats—at one time. Click ![Merge Screen](image) to merge the screens into a single screen.
Exporting Reports

You can export a report as a text or Microsoft Excel file by doing the following:

1. Select the report you want to view. See Viewing Reports on page 113 for more information.

2. In the Report Viewer toolbar, do one of the following:

   - Click to export the report as a text file. The text file appears in a popup window in your browser.

   - Click to export the report as a Microsoft Excel file.

3. Set the location where you want to save the file and save it.

Working with Documents in the Document Viewer

In the Document Viewer, you can view documents contained in the Folder Objects panel.

Your user role determines if you can annotate documents. For more information about roles, see Understanding User Roles and Privileges on page 48.

Note: If you open a document in an application other than Nolij Web, any document annotations that you created are no longer visible.

The following topics provide more information about the Document Viewer:

- Supported File Types on page 116.
- Document Viewer Toolbar and Right-Click Menu Options on page 121.
Chapter 4  Using Nolij Web

- Annotating Documents on page 126.
- Resizing Annotations on page 131.
- Moving Annotations on page 131.
- Modifying Annotation Colors on page 132.
- Modifying Annotation Text on page 134.
- Modifying Font Sizes on page 134.
- Deleting Annotations on page 132.
- Resizing Documents in the Document Viewer on page 135.
- Resizing the Document Viewer on page 135.
- Rotating Documents on page 136.
- Zooming in and Out on page 136.

Supported File Types

You can view the documents with file types of the following:

Nolij Web supports the following file types.

**Word Processor Formats**

- ODF Text Document (*.odt)
- ODF Text Document Template (*.ott)
- OpenOffice.org 1.0 Text Document (*.swx)
- OpenOffice.org 1.0 Text Document Template (*.swx)
- Microsoft Word 97, 2000, XP (*.doc)
- Microsoft Word 97, 2000, XP Template (*.dot)
Working with Documents in the Document Viewer

- Microsoft Word 6.0, 95 (*.doc)
- Microsoft Word 95 Template (*.dot)
- Rich Text Format (*.rtf)
- StarWriter 3.0 to 5.0 (*.sdw)
- StarWriter 3.0 to 5.0 Templates (*.vor)
- Text (*.txt)
- Text Encoded (*.txt)
- HTML Document (*.html; *.htm)
- ApportisDoc (Palm®) (*.pdb)
- DocBook (*.xml)
- Microsoft WinWord 5 (*.doc)
- Microsoft Word 2003 XML (*.xml)
- Microsoft Word 2007 XML (*.docx; *.docm)
- Microsoft Word 2007 XML Template (*.dotx; *.dotm)
- Pocket Word (*.psw)
- StarWriter 1.0 (*.sdw)
- StarWriter 2.0 (*sdw)
- StarWriter DOS (*.txt)
- T602 Document (*.602; *.txt)
- Unified Office Format Text (*.uot; *.uof)
- WordPerfect® Document (*.wpd)
- Hangul WP 97 (*.hwp)
Spreadsheets

- ODF Spreadsheet (*.ods)
- ODF Spreadsheet Template (*.ots)
- OpenOffice.org 1.0 Spreadsheet (*.sxc)
- OpenOffice.org 1.0 Spreadsheet Template (*.stc)
- Data Interchange Format (*.dif)
- dBASE (*.dbf)
- Microsoft Excel 97, 2000, XP (*.xls; *.xlc; *.xlm; *.xlw)
- Microsoft Excel 97, 2000, XP Template (*.xlt)
- Microsoft Excel 4.x to 5.0, 95 (*.xls; *.xlc; *.xlm; *.xlw)
- Microsoft Excel 4.x to 5.0, 95 Templates (*.xlt)
- Rich Text Format (OpenOffice.org Calc) (*.rtf)
- StarCalc 3.0 to 5.0 (*.sdc)
- StarCalc 3.0 to 5.0 Templates (*.vor)
- StarCalc 1.0 (*.sdc)
- SYLK (*.slk)
- Text CSV (*.csv; *.txt; *.xls)
- Microsoft Excel 2007 Binary (*.xlsb)
- Microsoft Excel 2007 XML (*.xslm; *.xlsx)
- Microsoft Excel 2007 XML Template (*.xltm, *.xltx)
- IBM Lotus 1-2-3 (*.wk1; *.wks; *.123)
- Microsoft Excel 2003 XML (*.xml)
- Pocket XML (*.pml)
- Unified Office Format spreadsheet (*.uos; *.uof)

**Presentation Formats**

- ODF Presentation (*.odp)
- ODF Presentation Template (*.otp)
- OpenOffice.org 1.0 Presentation (*.sxi)
- OpenOffice.org 1.0 Presentation Template (*.sti)
- Microsoft PowerPoint 97, 2000, XP (*.ppt; *.pps)
- Microsoft PowerPoint 97, 2000, XP Template (*.pot)
- OpenOffice.org 1.0 Drawing (OpenOffice.org Impress) (*.sxd)
- StarDraw 3.0, 5.0 (StarImpress) (*.sda; *.sdd)
- StarImpress 4.0, 5.0 (*.sdd; *.sdp)
- StarImpress 4.0, 5.0 (*.vor)
- CGM - Computer Graphics Metafile (*.cgm)
- Microsoft PowerPoint 2007 XML (*.pptm; *.pptx)
- Microsoft PowerPoint 2007 XML Template (*.potm; *.potx)
- Unified Office Format presentation (*.uop; *.uof)
- ODF Drawing (Impress) (*.odg)

**Drawing/Image Formats**

- ODF Drawing (*.odg)
- ODF Drawing Template (*.otg)
- OpenOffice.org 1.0 Drawing (*.sxd)
- OpenOffice.org 1.0 Drawing Template (*.std)
- StarDraw 3.0, 5.0 Templates (*.vor)
- PDF - Portable Document Format (*.pdf)
- SVM - StarView Metafile (*.svm)
- WMF - Windows Metafile (*.wmf)
- BMP - Windows Bitmap (*.bmp)
- GIF - Graphics Interchange Format (*.gif)
- JPEG - Joint Photographic Experts Group (*.jpg; *.jpeg; *.jfif; *.jif; *.jpe)
- PBM - Portable Bitmap (*.pbm)
- PCX - Zsoft Paintbrush (*.pcx)
- PGM - Portable Greymap (*.pgm)
- PNG - Portable Network Graphic (*.png)
- PPM - Portable Pixelmap (*.ppm)
- PSD - Adobe® Photoshop® (*.psd)
- RAS - Sun Raster Image (*.ras)
- TGA - Truevision Targa (*.tga)
- TIFF - Tagged Image File Format (*.tif; *.tiff)
- XBM - X Bitmap (*.xbm)
- XPM - X PixMap (*.xpm)
- PCD - Kodak Photo CD (768x512) (*.pcd)
- PCD - Kodak Photo CD (192x128) (*.pcd)
- PCD - Kodak Photo CD (384x256) (*.pcd)
Mail Messages

- MSG Microsoft Exchange Message Format (*.msg)
- TXT Encoded text mail message (*.eml; *.txt)

Web Pages

- MHT Microsoft Archived Web Format (*.mht)
- HTML - Hypertext Markup Language (*.html; *.htm)

Mathematical Notation

- ODF Formula (*.odf)
- OpenOffice.org 1.0 Formula (*.sxm)
- StarMath 2.0 to 5.0 (*.smf)
- MathML 1.01 (*.mml)

Document Viewer Toolbar and Right-Click Menu Options

The following table describes the icons in the Document Viewer toolbar and what you can do with them. You can also access many of these features and additional features when you right-click anywhere in the Document Viewer and open a popup menu of options.
### Table 7: Document Viewer Toolbar Icons, Right-Click Menu Options, and Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Right-Click Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Add scanned pages</td>
<td>Scan Append</td>
<td>Adds scanned pages from a scanner to the Nolij Web document. See Adding Scanned Pages to Documents on page 73.</td>
</tr>
<tr>
<td>N/A</td>
<td>Rescan page</td>
<td>Rescan Page</td>
<td>Rescans a page and replaces the selected page in the Document Viewer with the scanned page. See Rescanning Pages on page 72.</td>
</tr>
<tr>
<td>![Hand Mode]</td>
<td>Hand Mode</td>
<td>N/A</td>
<td>Allows you to select the document and move it with your pointer. The Document Viewer displays documents in sections. When you hover your mouse over the document in Hand Mode, the pointer changes to ┐. Then, click a document to select it; you can move the document in any direction, to view the desired portion of the document.</td>
</tr>
<tr>
<td>![Select]</td>
<td>Select</td>
<td>N/A</td>
<td>Allows you to select an annotation for editing.</td>
</tr>
<tr>
<td>![Print]</td>
<td>Print</td>
<td>N/A</td>
<td>Prints a document. See Printing Documents on page 125.</td>
</tr>
<tr>
<td>![Extract Page From Document]</td>
<td>Extract Page From Document</td>
<td>N/A</td>
<td>Extracts a selected page from the document. See Extracting Pages From Documents on page 125.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
<td>Right-Click Menu Option</td>
<td>Function</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>📝</td>
<td>Annotations Tools</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🟢</td>
<td>Highlight</td>
<td>Highlight</td>
<td>Highlights a document. See <a href="#">Highlighting Documents on page 127</a>.</td>
</tr>
<tr>
<td>⌼</td>
<td>Redaction</td>
<td>Redaction</td>
<td>Redacts (obscures) an area of the document. See <a href="#">Redacting Documents on page 128</a>.</td>
</tr>
<tr>
<td>👤</td>
<td>Stamp</td>
<td></td>
<td>Provides options for stamping a document with a graphic or text stamp. See <a href="#">Stamping Documents on page 128</a>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This option appears only if you have privileges to view and use stamps.</td>
</tr>
<tr>
<td>🟢</td>
<td>Circle</td>
<td>Draw a circle on the document. See <a href="#">Drawing Circles on page 129</a>.</td>
<td></td>
</tr>
<tr>
<td>🟦</td>
<td>Free Text</td>
<td>Draw a square on the document. See <a href="#">Drawing Squares on page 130</a>.</td>
<td></td>
</tr>
<tr>
<td>🟦</td>
<td>Square</td>
<td>Draw a square on the document. See <a href="#">Drawing Squares on page 130</a>.</td>
<td></td>
</tr>
<tr>
<td>🟦</td>
<td>Sticky Note</td>
<td>Add a sticky note to the document. See <a href="#">Adding Sticky Notes on page 130</a>.</td>
<td></td>
</tr>
<tr>
<td>Hide</td>
<td>Hide</td>
<td></td>
<td>Shows or hides document annotations. See <a href="#">Showing and Hiding Annotations on page 126</a>.</td>
</tr>
<tr>
<td>🔄 ➩</td>
<td>Rotate clockwise</td>
<td>N/A</td>
<td>Rotates the document clockwise. See <a href="#">Rotating Documents on page 136</a>.</td>
</tr>
<tr>
<td>🔄 ➩</td>
<td>Rotate counterclockwise</td>
<td>N/A</td>
<td>Rotates the document counterclockwise. See <a href="#">Rotating Documents on page 136</a>.</td>
</tr>
<tr>
<td>🕵</td>
<td>Zoom In</td>
<td>Zoom In</td>
<td>Zooms in on the document. See <a href="#">Zooming in and Out on page 136</a>.</td>
</tr>
<tr>
<td>🕵</td>
<td>Zoom Out</td>
<td>Zoom Out</td>
<td>Zooms out of the document. See <a href="#">Zooming in and Out on page 136</a>.</td>
</tr>
</tbody>
</table>
Table 7: Document Viewer Toolbar Icons, Right-Click Menu Options, and Descriptions (Continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Right-Click Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Fit Width Icon" /></td>
<td>Fit Width</td>
<td>Fit Width</td>
<td>Resizes the document to fit it into the width of the Document Viewer. See Resizing Documents in the Document Viewer on page 135.</td>
</tr>
<tr>
<td><img src="image" alt="Fit Page Icon" /></td>
<td>Fit Page</td>
<td>Fit Page</td>
<td>Resizes the document to fit it into the entire Document viewer. See Resizing Documents in the Document Viewer on page 135.</td>
</tr>
<tr>
<td><img src="image" alt="Maximize Icon" /></td>
<td>Maximize</td>
<td>N/A</td>
<td>Resizes the Document Viewer so that it fits into the entire browser window. See Resizing the Document Viewer on page 135.</td>
</tr>
<tr>
<td><img src="image" alt="Restore Icon" /></td>
<td>Restore</td>
<td>N/A</td>
<td>Restores the Document Viewer to its original size, after you maximize or vertically maximize it.</td>
</tr>
<tr>
<td><img src="image" alt="Save Icon" /></td>
<td>Save</td>
<td>N/A</td>
<td>Saves annotations to the document.</td>
</tr>
</tbody>
</table>

When a multipage document is open, elements for multipage navigation appear. These allow you to navigate to different pages in a document. The bookmark elements also appear.

Figure 28: Multipage Navigation Elements

![Multipage Navigation Elements](image)

In addition, if you have a mouse with a mouse wheel, you can use it to navigate to the next or previous page. When you are at the top of a document page and scroll up on the mouse wheel, you navigate to the previous page; when you are at the bottom of a page and scroll down, you navigate to the next page.

Figure 29: Bookmark Elements

![Bookmark Elements](image)

For more information on bookmarking, see Bookmarking Documents on page 137.

You can show or hide the bookmark elements. See Hiding and Showing Bookmarks on page 45.
If a document is too large to be fully displayed in the Document Viewer, scrollbars appear; you can use the scrollbars to navigate to portions of the document that are not displayed. If you use a mouse with a mouse wheel, you can vertically scroll through a document.

**Printing Documents**

To print a document, do the following:

1. In the Document Viewer toolbar, click 📄.  
   The Print dialog box for the browser appears.
2. Set the appropriate print settings and print the document.  
   Any document annotations are printed.

**Extracting Pages From Documents**

To extract a page from a document, do the following:

1. In the Document Viewer, navigate to the page of the document that you want to extract.

2. In the Document Viewer toolbar, click 📄.  
   The Extract Page dialog box appears, asking if you want to delete the extracted page from the document.

3. If you want to delete the extracted page, click **Yes**. If you do not want the page deleted, click **No**.  
   The page is extracted from the document, and it appears in the Folder Objects panel, which refreshes to display the extracted page as a new document.
Showing and Hiding Annotations

To show or hide annotations in a document, click 
, then select Hide from the popup menu.

Annotating Documents

Your user role determines if you can annotate documents. For more information about roles, see Understanding User Roles and Privileges on page 48.

You can annotate a document in a number of ways, such as highlighting information, adding text, and inserting sticky notes.

Note: When you add an annotation, you can continue to add annotations of the same type until you click 
 or 
 .

Note: The annotation size, font size, and background color you use are saved as preferences for that annotation type. The next time you add annotations of a particular annotation type, these preferences are applied.

Note: See these topics for detailed information:

- Highlighting Documents on page 127.
- Redacting Documents on page 128.
- Stamping Documents on page 128.
- Drawing Circles on page 129.
• Drawing Circles on page 129.
• Adding Free Text on page 129.
• Drawing Squares on page 130.
• Adding Sticky Notes on page 130.

Note: You cannot see annotations if you open a document in an application outside Nolij Web.

Highlighting Documents

To highlight a document, do the following:

1. Do one of the following:
   • Click , then click in the Document Viewer toolbar.
   • Right-click anywhere in the Document Viewer and select Annotation Tools > Highlight from the popup menu.

2. Click the document and drag your mouse across the area you want the highlight to appear.

3. Click to save your changes.


Redacting Documents

To obscure an area of a document, do the following:

1. Do one of the following:
   
   - Click 📝, then click 📝 in the Document Viewer toolbar.
   
   - Right-click anywhere in the Document Viewer and select Annotation Tools > Redaction from the popup menu.

2. Click the document in the area you want to obscure and drag your mouse across the area you want the redaction to appear.

3. Click 📝 to save your changes.

Stamping Documents

Your user role determines if you can stamp documents. For more information about roles, see Understanding User Roles and Privileges on page 48.

To place a rubber stamp on a document, do the following:

1. Do one of the following:

   - Click 📝, then click 📝 in the Document Viewer toolbar.

   - Right-click anywhere in the Document Viewer and select Annotation Tools > Stamp from the popup menu.

2. To add a custom image or text stamp, which are configured by your administrator, select the appropriate stamp from popup menu.

3. Click the document in the area you want to stamp and drag your mouse across it.

4. Click 📝 to save your changes.
Drawing Circles

To draw a circle on a document, do the following:

1. Do one of the following:
   - Click ![pencil](image), then click ![circle](image) in the Document Viewer toolbar.
   - Right-click anywhere in the Document Viewer and select **Annotation Tools > Circle** from the popup menu.

2. Click the document and drag your mouse across the area you want the circle to appear.

3. Click ![save](image) to save your changes.

Adding Free Text

To place a text box on a document, do the following:

1. Do one of the following:
   - Click ![pencil](image), then click ![text](image) in the Document Viewer toolbar.
   - Right-click anywhere in the Document Viewer and select **Annotation Tools > Free Text** from the popup menu.

2. Click the document and drag your mouse across the area you want the text box to appear.

3. Click ![save](image) to save your changes.
Chapter 4  Using Nolij Web

Drawing Squares

To draw a square on a document, do the following:

1. Do one of the following:
   - Click \[\text{\textbullet}\] , then click \[\text{\textbullet}\] in the Document Viewer toolbar.
   - Right-click anywhere in the Document Viewer and select Annotation Tools > Square from the popup menu.

2. Click the document and drag your mouse across the area you want the square to appear.

3. Click \[\text{\textbullet}\] to save your changes.

Adding Sticky Notes

To add a sticky note to a document, do the following:

1. Do one of the following:
   - Click \[\text{\textbullet}\] , then click \[\text{\textbullet}\] in the Document Viewer toolbar.
   - Right-click anywhere in the Document Viewer and select Annotation Tools > Sticky Note from the popup menu.

2. Click the document drag your mouse across the area you want the sticky note to appear.

3. Click \[\text{\textbullet}\] to save your changes.
Resizing Annotations

To resize an annotation:

1. In the Document Viewer toolbar, click 🕹️.
2. In the Document Viewer, place your mouse on the edge of an annotation until the mouse pointer changes to ⬅️ (to resize horizontally), to ⬇️ (to resize vertically), or to or to ⬅️ or ⬆️ (to resize both horizontally and vertically).
3. Click the annotation and drag and drop it to the desired location to resize it.
4. Click 🕷️ to save your changes.

Moving Annotations

1. In the Document Viewer toolbar, click 🕹️.
2. In the Document Viewer, click the annotation you want to move.
3. Drag and drop it to the location in which you want it to appear.
4. Click 🕷️ to save your changes.
Deleting Annotations

To delete an annotation:

1. In the Document Viewer toolbar, click ☑️.

2. In the Document Viewer, right-click the annotation you want to delete.

3. From the popup menu, select Delete Annotation.

   The annotation is deleted.

4. Click ☑️ to save your changes.

Modifying Annotation Colors

You can modify the background color of annotations (except free text), and you can modify the font color of free text and sticky note annotations. The colors you select for an annotation are saved as preferences for the annotation type.

1. In the Document Viewer toolbar, click ☑️.

2. In the Document Viewer, right-click the annotation for which you want to modify colors and select Color from the popup menu.

3. You can select a color from the color pallet that appears in the popup menu, or you can set a custom color by selecting Color Chooser. Proceed to the next step if you are setting a custom color.
4. Set the color of the annotation by doing any of the following:

- Use the color selector or color slider.

  In the color selector area, select ○ and move it to the desired color, or click the color slider and move it to the desired color.

- Set a color by providing the appropriate values in the H, S, and V text fields to configure the hue, saturation, and value.

  1. Click the H radio button and type a number in the H text field or use the color slider to set the hue. Hue is expressed as an angle from 0 to 360 degrees corresponding to a location on the color wheel.

  2. Set the saturation and value. Click the S or V radio button and set the value using the color selector area or the color slider, or type numbers in the S or V fields. Saturation and value are expressed as percentages.

- Set a color by providing the appropriate values in the R, G, and B fields by configuring the value of red, green, and blue components of a color. Do one of the following:

  - Click the R, G, or B radio button and type numbers in the R, G, and B text fields. Valid values range from 0 to 255, where 0 is no color, and 255 is pure color.

  - Click the R, G, or B radio button and set the color using the color selector area or the color slider.

- Set a color by providing its hexadecimal value, which is the six-digit number that defines the red, green, and blue components of a color. Each digit ranges in value from 0 to f.

  In the # text field, type the hexadecimal value. For instance, type ffffff for white or ff0000 for pure red.

5. Click **Save** to save your changes and close the dialog box.

6. Click ☐ to save your changes.
Modifying Annotation Text

You can modify the text in free text and sticky note annotations by doing the following:

1. In the Document Viewer toolbar, click 

2. In the Document Viewer, right-click the annotation for which you want to modify text.

3. From the popup menu, select **Edit Text**.

4. Add, modify, and delete text as appropriate.

5. Click to save your changes.

Modifying Font Sizes

You can modify the font size of the text in free text and sticky note annotations by doing the following:

1. In the Document Viewer toolbar, click 

2. In the Document Viewer, right-click the annotation for which you want to modify the font size.

3. From the popup menu, select **Font Size**.

   The Font Size dialog box appears.

4. Type the font size that you want to use; values can be 1 through 50. The higher the value, the larger the font size.

5. Click **OK** to close the dialog box and apply your changes.

6. Click to save your changes.
Resizing Documents in the Document Viewer

Do one of the following:

To resize a document to fit the width of the Document Viewer, do one of the following:

- Click in the Document Viewer toolbar.
- Right-click anywhere in the Document Viewer and select **Fit Width** from the popup menu.

To resize a document to fit in the entire area of the Document Viewer, do one of the following:

- Click in the Document Viewer toolbar.
- Right-click anywhere in the Document Viewer and select **Fit Page** from the popup menu.

You cannot zoom out of a document that fits in the entire area of the Document Viewer.

Resizing the Document Viewer

You can resize the Document Viewer by doing the following:

- To resize the Document Viewer to fit into the entire width of the browser window, click in the Document Viewer toolbar. All other panels, excluding the main toolbar and the Form panel (if it is configured), are no longer displayed. To restore the Document Viewer to its original size and to restore the excluded panels, click .
- To resize the Document Viewer to fit into the entire height of the browser window, **Preferences > View Options > Vertical** from the toolbar. The Query area and the Workflow area (if it is displayed) are no longer displayed. All other panels are no longer displayed. They are collapsed to the left of the Document Viewer.
To view the collapsed elements, point your mouse to the left edge of the document viewer, until the mouse pointer changes to \( \downarrow \); then, drag and drop your mouse to resize and view the elements. The Query and Workflow areas appear above the panels.

You can also select **Preferences > View Options > Vertical** from the toolbar to resize the panels in this manner.

**Rotating Documents**

Do one of the following:

- To rotate a document counterclockwise, click \( \downarrow \) in the Document Viewer toolbar.

- To rotate a document clockwise, click \( \uparrow \) in the Document Viewer toolbar.

Any annotations are also rotated.

**Zooming in and Out**

To magnify (zoom in) the size of a document, do one of the following:

- Click \( \times \) in the Document Viewer toolbar.

- Right-click anywhere in the Document Viewer and select **Zoom In** from the popup menu.
To reduce (zoom out) the size of a document, do one of the following:

- Click in the Document Viewer toolbar.
- Right-click anywhere in the Document Viewer and select Zoom Out from the popup menu.

You cannot zoom out of a document that fits the entire area of the Document Viewer.

**Bookmarking Documents**

You can add bookmarks to pages in multipage documents, which you can use to navigate to a specific page.

You can show or hide the bookmark elements. See Hiding and Showing Bookmarks on page 45.

See these topics for more information:

- Adding Bookmarks on page 137.
- Deleting Bookmarks on page 138.

**Adding Bookmarks**

To add bookmark to a page, do the following:

1. In the Document Viewer, navigate to the page you want to bookmark.
2. In the bookmark field in the toolbar, type the text you want to use for the bookmark.
3. Click .
The page is bookmarked. You can navigate to a bookmarked page by selecting the appropriate bookmark from the bookmark drop-down list or clicking the ▶ or ▼ buttons.

Deleting Bookmarks

To delete a bookmark, do the following:

1. In the Document Viewer in the toolbar, select the bookmark that you want to delete in the bookmark field.

2. Click ▼.

The bookmark is deleted.

Working with the Tools Menu

See the following topics for more information:

- Working with the Communication Window on page 139.
- Viewing the Graphical Workflow on page 141.
- Viewing the User Summary on page 147.
Working with the Communication Window

You can communicate with other Nolij Web users and view informational and debug messages in the Communication panel. See these topics for more information:

- Collaborating with Nolij Web Users on page 139.
- Viewing Console Messages on page 140.
- Viewing Debug Messages on page 141.

Collaborating with Nolij Web Users

Note: You can communicate only with other users who have permission to use the collaboration tool.

To collaborate with other users, do the following:

1. In the main toolbar, click Tools.

2. Select Communication Window from the popup menu.

   The Communication Window dialog box appears.

3. Click the Collaboration tab.

   A list of Nolij Web users and their corresponding roles appears.

   Initially, you can view only users who are online or who have been online since you logged in. To see all users in a role, both online and offline, double-click the role. The names of users who are offline appear in italics.

4. Double-click the user with whom you want to communicate.

   A dialog box appears in which you type the desired text.
You can send messages to offline users. An offline user receives the message the next time he or she logs in. The message you send contains the time and date that you sent it.

**Note:** You cannot see messages sent to you unless you are logged in using the role to which messages were sent.

5. Click **Send** to send the message to the user.

**Viewing Collaboration History**

To view all previous messages you have sent to and received from another user, do the following:

1. Open a collaboration session with the user. See **Collaborating with Nolij Web Users** on page 139.

2. Click ![image](image) in the collaboration dialog box.

3. Click **Show All History**.
   
   All messages exchanged between you and the other user are displayed.

**Viewing Console Messages**

In the Collaboration window, click the **Console** tab to view informational messages, such as the number of results returned from a query.

To clear messages, click ![image](image) and click **Clear**.
Viewing Debug Messages

If problems related to the user interface occur, the Debug tab appears in the Communication panel; click it to view debug messages.

Viewing the Graphical Workflow

You can view a graphical representation of the workflow process in the Graphical Workflow dialog box. The workflow defines the path through which folders of information are routed in your institution based upon the criteria defined for your Nolij Web setup.

The following table provides descriptions of the icons in this dialog box.

Table 8: Graphical Workflow Icons and Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Workflow" /></td>
<td>Workflow name.</td>
</tr>
<tr>
<td><img src="image" alt="Inbox" /></td>
<td>Inbox to which a folder of information is routed. You can work with documents in a folder when a folder is in an inbox you own.</td>
</tr>
<tr>
<td><img src="image" alt="Complete Step" /></td>
<td>Complete Step action, which is associated with an inbox. It represents that work on the folders in the inbox has been completed and that folders can be sent to the next inbox in the workflow.</td>
</tr>
</tbody>
</table>
Table 8: Graphical Workflow Icons and Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Condition Icon" /></td>
<td><em>Condition</em>, which sends a folder to only one of two possible workflow paths (<em>Yes</em> or <em>No</em>). Frequently, conditions appear in the form of a question. Conditions are configured by your Nolij Web administrator.</td>
</tr>
</tbody>
</table>

For example, a condition may be named *Is this a domestic application?* for the following scenario:

- Applications with U.S. mailing addresses are sent to an assistant responsible for reviewing domestic applications.

- Applications with non-U.S. mailing addresses are sent to a different assistant who is responsible for reviewing non-U.S. applications.

Applications with U.S. mailing addresses satisfy *Yes* and move to the appropriate workflow path; applications with non-U.S. mailing addresses satisfy *No* and move to the appropriate workflow path.

See [Figure 30 on page 144](#) for an example of the graphical workflow for this scenario.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🃁</td>
<td>Yes condition; when this criteria is met, a folder is routed to this workflow branch.</td>
</tr>
<tr>
<td>🎎</td>
<td>No condition; when this criteria is met, a folder is routed to this workflow branch.</td>
</tr>
<tr>
<td>🐧</td>
<td>Rule, which sends a folder to a workflow path, depending on the criteria defined. Rules route folders through one out of two or more workflow paths, while conditions route folders through one of only two possible workflow paths. Rules are configured by your Nolij Web administrator.</td>
</tr>
</tbody>
</table>

For example, a rule may be named *Route by last name* for the following scenario:

Applications are sent to five different assistants to review, and assistants are responsible for reviewing applications based on the last letter of the student’s last name. Folders are routed to the appropriate assistant by the following:

- Last names beginning with A through E
- Last names beginning with F through J
- Last names beginning with K through O
- Last names beginning with P through T
- Last names beginning with U through Z

In this scenario, folders are routed through one of five possible workflow paths.

See **Figure 31 on page 145** for an example of the graphical workflow for this scenario.
Figure 30: Condition Example

admission

application received (121)

Complete Step

Is this a U.S. application?

YES

U.S. applications

NO

non-U.S. applications
Figure 31: Rule Example

Do one of the following:

- In the main toolbar, click ![Tools](image) and select **Graphical Workflow** from the popup menu.

- Right-click an inbox or drop-down box in the Workflow area and select **Graphical Workflow** from the popup menu.
The Graphical Workflow dialog box appears.

Figure 32: Graphical Workflow Dialog Box

Click an icon and drag and drop it to move it.

You can move the dialog box by clicking on it; when the mouse pointer changes to \( \textcircled{+} \), press down on your mouse and move the window to the appropriate location.

To resize the dialog box, place your mouse on the edge of the form until the mouse pointer changes to \( \rightarrow \rightarrow \) (to resize horizontally), \( \uparrow \) (to resize vertically), or to \( \leftarrow \) or \( \uparrow \) (to resize both horizontally and vertically).

You can close the dialog box by clicking \( \times \).
Moving Folders in a Workflow

Note: If you click the Work Complete button to route a folder, and the folder can be routed to the next inbox, the inboxes to and from which the folder is routed are highlighted in the Graphical Workflow dialog box, and the folder moves to the appropriate inbox.

Viewing the User Summary

You can view the number of folders in each of your inboxes associated with the workflows for all your Nolij Web roles by doing the following:

1. In the main toolbar, click

2. Select User Summary from the popup menu.

   The Workflow Status dialog box appears and displays the following information.
   - Role—Name of the role to which you belong.
   - Workflow—Name of the workflow associated with the role.
   - Inbox—The inbox, associated with the workflow, to which you have access.
   - Count—Number of folders in the inbox.

3. Click OK to close the dialog box.

Moving Folders in a Workflow

After you have finished performing your work, you can manually send the folder to the next inbox in the workflow, or Nolij Web can automatically route the documents to the next inbox, depending on your Nolij Web configuration.
When documents are submitted, the entire folder containing all associated documents is sent to the next inbox.

**Moving Folders Manually**

You can override the automatic workflow process for a folder for which you have the appropriate privileges doing one of the following:

- Right-clicking a folder in the Query Results panel, selecting **Move to**, and selecting the inbox to which to send the folder.

- Clicking an inbox in the Workflow area; then, right-clicking the folder from the Inbox Detail dialog box, selecting **Move to**, and selecting the inbox to which to send the folder.

- Clicking a folder in the Query Results panel; then, selecting the inbox drop-down box in the Workflow area, selecting **Move to**, and selecting the inbox to which to send the folder.

The Move To option is dimmed and unavailable if you do not have permission to move the folder.

**Moving Folders in an Automatic Workflow**

In an automatic workflow, when you click **Work Complete** in the toolbar or from the folder’s right-click menu in the Query Results panel, the workflow process starts, and Nolij Web routes the folder to the appropriate inbox when the proper conditions are met.

**Note:** **Work Complete** is dimmed and unavailable if a folder is at the end of a workflow and cannot move to another inbox, if you have not selected a folder, or if you do not have privileges to move the folder.
To automatically route the folder:

- Click the folder in the Query Results panel, then click ![Work Complete](image) in the toolbar.

- Right-click the folder in the Query Results panel and select Work Complete from the popup menu.

One of the following occurs:

- The Workflow Step dialog box appears if the folder cannot be submitted, and it indicates the reason that the process could not be completed.

  The folder is not routed.

- The Workflow Step Completed dialog box appears if the document was successfully routed.

**Note:** You cannot route a folder that is not associated with a workflow. For example, batch folders are typically not associated with a workflow and cannot be routed.

If the Graphical Workflow dialog box is open, the inboxes to and from which the folder is routed are highlighted in blue, and the folder moves between the inboxes.

You can also remove folders from the workflow, if you have the appropriate privileges. See Setting Custom Statuses for Folders on page 64.
Removing Folders from the Workflow

If you have the appropriate privileges, you can remove a folder from your workflow.

- Right-click a folder in the Query Results panel and select **Remove from Workflow** from the popup menu.

  The folder is removed from the workflow; however, the folder remains displayed in the Query Results pane.

- Select the inbox in the Workflow area to open the Inbox Detail dialog box; then, right-click a folder in the Inbox Detail dialog box and select **Remove from Workflow** from the popup menu.

  The folder is removed from the workflow and is also removed from the Inbox Detail dialog box.

If you remove a folder from the workflow, or if a folder is not in a workflow, when you click a folder in the Query Results panel, *Not in Workflow* appears next to the Workflow label, and the **Move To** option is dimmed and unavailable. See Figure 4 on page 37.
Appendix A  Troubleshooting Nolij Web

See Java Applet Errors for information about troubleshooting Nolij Web.

Java Applet Errors

When Nolij Web loads, it requests the browser to load an applet. The browser should either start Java Runtime Engine (JRE), if it is installed on the computer, or prompt you to download JRE.

However, you may receive messages in Nolij Web or from your browser about Java errors, such as problems communicating with Java Applets or RuntimeException errors. This could be caused by any of the following:

- You may have permanently rejected the prompt to download and install the appropriate version of JRE.
- The browser is configured to reject applets.
- An older version of JRE is installed on your computer, and it is incompatible with Nolij Web.

To work around this issue, check the version of Java running on your computer by going to http://www.java.com/en/download/help/testvm.xml. You can download the appropriate version of JRE from this website if necessary.

It is recommended that you use JRE 1.6.0_13 or later.
Index

A
annotating documents, 126
annotations
deleting, 132
modifying
colors, 132
font sizes, 134
moving, 131
resizing, 131

B
batch folder
deleting, 60
batch folders
creating, 59
batch queries
performing, 58
bookmark
add, 137
delete, 138
bookmarks
hiding, 45
showing, 45

C
circles
drawing, 129
collaborate, 139
colors
changing, 44
console messages, view, 140
custom status, 64

D
debug messages, view, 141
display
configuring, 44
document properties
viewing, 82
document viewer
resizing, 135
document viewer toolbar, 121
documents
deleting, 94
recovery, 95
duplicating, 95
emailing, 98
indexing, 89
merging, 96
moving into folder objects
subfolders, 97
moving into query folder, 97
recovery, 95
renaming, 92
resizing, 135
rotating, 136
versions
creating, 79

E
extracting pages, 125

F
features, 14
field
Index

moving, 43
resizing, 43
folders
  removing from workflow, 150
forms, 110
  attaching, 46
  detaching, 46
free text
  adding, 129
G
global documents, 91
graphical workflow
  viewing, 141
H
highlighting documents, 127
I
index list, 92
L
lines
  drawing, 129
  logging in, 29
O
OCR
  words
    adding, 82
    correcting, 82
    dictionary, 82
    rejecting, 82
OCR properties
  viewing, 82, 84
overview, 13
P
panel
  collapsing, 42
  expanding, 42
  resizing, 42
preferences, 43
printing, 125
privileges
  understanding, 48
Q
queries
  performing, 52
query
  clearing, 64
query folder
  locking, 63
query results
  clearing, 62
  locking, 63
R
redacting documents, 128
report
  exporting, 115
report viewer toolbar, 112
reports
  viewing, 113
role
  changing, 46
roles
  understanding, 48
S
scanning, 67
  blank pages, 70
  inserting pages, 73
  rescanning pages, 72
  scanning into folders and
    subfolders, 68
  scanning multipage documents, 69
  single-page documents, 68
searching
  documents in the Folder Objects
    panel, 102
  keyword, 104
shared documents, 92
squares
  drawing, 130
  stamping documents, 128
starting Nolij Web, 29
sticky notes
  adding, 130
subindex queries
  performing, 55
T
  toolbar
document viewer, 121
  main, 34
  report viewer, 112

U
  user interface
    understanding, 31
  user summary
    viewing, 147

V
  versions
    documents
      creating, 79

Z
  zooming in, 136
  zooming out, 136